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ABSTRAK 
 

 

Flotasi adalah proses pemisahan mineral berharga berdasarkan sifat 

permukaan mineral, yaitu hydrophobic dan hydrophilic. Dalam flotasi, efisiensi 

sangat penting dan dapat ditentukan dari performa metalurgis, yaitu recovery, 

sehingga proses flotasi perlu dimonitor dengan baik. Saat ini, teknologi Machine 
Vision digunakan untuk memonitor proses flotasi di industri, namun teknologi ini 

hanya dapat memonitor di sumbu-x dan sumbu-y, sehingga kurang representatif 

karena pemisahan mineral terjadi di sumbu-z (collection zone). Teknologi sensor 

berbasis kapasitansi listrik memanfaatkan perbedaan kapasitansi material untuk 

memonitor flotasi secara real-time dan bersifat non-intrusif, sehingga lebih unggul 

dibandingkan teknologi sebelumnya dalam mengoptimalkan efisiensi proses flotasi 

kolom. Penelitian ini bertujuan untuk mengetahui hubungan antara kapasitansi dan 

recovery flotasi kolom. Kolektor yang digunakan adalah methyl ester sulfonate, 

sedangkan frother pine oil divariasikan pada dosis 20 ppm, 30 ppm, 40 ppm, dan 

50 ppm. Variasi ukuran partikel yang digunakan adalah -100+150#, -150+200#, -

200+230#, dan -230#, dengan laju alir udara 2,5 L/menit. Pengukuran kapasitansi 

dilakukan pada kondisi steady state (level 5). Hasil penelitian menunjukkan bahwa 

semakin tinggi dosis frother, semakin tinggi recovery yang diperoleh. Namun, 

ketika dosis frother terlalu tinggi, maka recovery akan menurun karena terjadinya 

entertainment non-selektif. Semakin kasar ukuran partikel yang digunakan, maka 

recovery akan semakin menurun. Recovery tertinggi mencapai 80,25% dengan 

kapasitansi 26,91 pF pada dosis frother 40 ppm dan ukuran partikel -230#, 

sedangkan recovery terendah adalah 2,17% dengan kapasitansi 24,6 pF pada dosis 

frother 50 ppm dan ukuran partikel -100+150#. Korelasi antara kapasitansi dan 

recovery didapatkan melalui persamaan matematis dari masing-masing variabel. 

Pada variasi ukuran partikel persamaan matematis yang didapat yaitu 

y = -1×10
-5

x4- 0,0019x3 + 0,0789x
2
 – 0,3315x + 0,5651 dengan polinomial orde 4 

di mana R2 = 0,9822. Sementara persamaan matematis yang didapat untuk variasi 

dosis frother adalah y = -0,0021x4+ 0,1432x3 + 3,5862x2 + 38,674x -76,742 dari 

polinomial orde 4 dengan R2 = 0,9827. 

 

Kata kunci: Sensor Berbasis Kapasitansi, Flotasi Kolom, Recovery, Tren. 
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BAB I 

PENDAHULUAN 

 

 

1.1 Latar Belakang 

Industri pertambangan di Indonesia terus menunjukkan pertumbuhan 

signifikan, seiring dengan peningkatan produksi berbagai komoditas tambang. 

Berdasarkan data Kementerian ESDM (Energi dan Sumber Daya Mineral), realisasi 

produksi batu bara pada tahun 2023 mencapai 775,2 juta ton, atau 112% dari target 

yang ditetapkan. Peningkatan ini sejalan dengan peningkatan investasi di sektor 

pertambangan yang mencapai USD 7,46 miliar, atau 96,8% dari target tahun 

tersebut. Investasi besar ini tidak hanya mendorong peningkatan produksi. Selain 

peningkatan produksi, pemanfaatan teknologi dalam sektor pertambangan menjadi 

faktor penting untuk menjaga efisiensi dan produktivitas di tengah tingginya 

permintaan komoditas tambang. Penggunaan teknologi di sektor pertambangan, 

salah satunya dalam bidang produksi, hingga pengolahan, semakin diperlukan 

untuk menghadapi tantangan peningkatan produksi dan memenuhi target yang 

semakin tinggi. Salah satu teknologi yang sangat berperan penting dalam mengolah 

produk tambang adalah teknologi flotasi kolom.  

Flotasi merupakan salah satu teknik konsentrasi yang memanfaatkan 

perbedaan sifat permukaan mineral untuk memisahkan mineral berharga dari 

pengotornya. Sifat permukaan ini didasari oleh respon permukaan mineral ketika 

berinteraksi dengan air, di mana ada dua jenis, yaitu hydrophobic (mineral yang 
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tidak menyukai air) dan hydrophilic (mineral yang menyukai air). Mekanisme 

flotasi kolom dilakukan dengan memasukkan bijih (feed) dari feeder, lalu udara 

diinjeksikan melalui sparger dari dasar kolom dengan laju tertentu. Ini menciptakan 

aliran berlawanan (counter-current) antara partikel dan gelembung, di mana 

partikel hydrophobic akan menempel pada gelembung dan ikut terangkat ke 

permukaan sebagai konsentrat, sementara partikel hydrophilic akan mengendap 

sebagai tailing. Dalam flotasi, efisiensi merupakan hal yang penting, di mana 

efisiensi ini dapat dilihat dari performa metalurgisnya yaitu recovery. 

Karena efisiensi flotasi merupakan hal yang krusial, diperlukan teknologi 

yang dapat memonitor jalannya proses flotasi agar tetap terkontrol dan efisiensi 

proses flotasi tetap terjaga. Teknologi yang saat ini umum digunakan di industri 

adalah Machine Vision. Namun, teknologi ini kurang representatif karena hanya 

dapat memonitor dari sumbu-x dan sumbu-y, sedangkan proses pemisahan 

berlangsung di sumbu-z. Kekurangan ini mendorong pengembangan teknologi 

sensor berbasis kapasitansi listrik. Sensor ini mampu memonitor secara real-time 

dan bersifat non-intrusif yang berarti tidak mengganggu proses berjalan, sehingga 

dapat digunakan untuk memonitor pada collection zone. Monitoring dalam proses 

flotasi memiliki peran yang sangat penting karena efisiensi dari proses flotasi dapat 

diketahui, sehingga dapat mencapai nilai recovery yang optimum. 

Pada penelitian sebelumnya yang dilakukan oleh Haryono dkk. (2020) 

memanfaatkan sistem Electrical Capacitance Volume Tomography (ECVT) untuk 

memonitor proses flotasi dengan menghasilkan citra warna yang merepresentasikan 

distribusi partikel dan udara dalam kolom flotasi. Penelitian ini berhasil 
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menunjukkan hubungan antara recovery dengan citra yang dihasilkan dari variasi 

penelitian yang digunakan, yaitu dosis frother dan kolektor. Meskipun begitu, 

penelitian tersebut belum mengaitkan kapasitansi secara mendalam dengan bentuk 

kurva recovery flotasi kolom, dan bagaimana sinyal kapasitansi dapat digunakan 

untuk memprediksi recovery. Oleh karena itu, penelitian ini dilakukan untuk 

mengoptimalkan monitoring proses flotasi kolom dengan menggunakan material 

silikon karbida (SiC) dan sensor kapasitif 2-channel yang terhubung ke 

kapasitometer. Data yang diperoleh akan diplot dalam bentuk kurva kemudian 

dilakukan pendekatan untuk memprediksi nilai recovery berdasarkan kapasitansi. 

 

1.2 Identifikasi Masalah 

 Berdasarkan latar belakang yang telah dijelaskan sebelumnya, beberapa 

identifikasi masalah yang timbul dalam penelitian ini meliputi:  

1. Pengaruh variasi ukuran partikel dan dosis frother terhadap nilai 

recovery dan kapasitansi dalam proses flotasi kolom.  

2. Hubungan dari kurva nilai kapasitansi dengan recovery yang didapat. 

3. Pendekatan matematis yang digunakan untuk memprediksi nilai 

recovery berdasarkan kapasitansi yang diperoleh. 

 

1.3 Tujuan Penelitian 

 Setelah mendapatkan permasalahan yang ada, maka tujuan dari penelitian 

ini, yaitu: 
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1. Menganalisis bagaimana variasi ukuran partikel dan dosis frother 

mempengaruhi nilai recovery dan kapasitansi dalam proses flotasi 

kolom. 

2. Mengetahui hubungan recovery dengan kapasitansi berdasarkan kurva 

monitoring. 

3. Mengetahui pendekatan matematis dari masing-masing variabel untuk 

memprediksi nilai recovery berdasarkan perolehan kapasitansi. 

 

1.4 Batasan Masalah 

Batasan masalah dalam penelitian ini yang dibutuhkan untuk mengarahkan 

fokus penelitian dengan jelas dan spesifik sebagai berikut: 

1. Bijih yang digunakan pada penlitian ini berupa bijih silikon karbida 

sintesis sebagai partikel hydrophobic dan pasir silika sebagai partikel 

hydrophilic. 

2. Proses preparasi material, proses flotasi, dan proses grain counting 

dilakukan di Laboratorium Advanced Materials and Tomography, 

Universitas Sultan Ageng Tirtayasa. 

3. Variasi yang digunakan pada penlitian ini meliputi ukuran partikel yaitu 

-100+150#, -150+200#, -200+230#, dan -230#, serta dosis pine oil 

sebagai frother yaitu 20 ppm, 30 ppm, 40 ppm, dan 50 ppm. 

4. Flotasi kolom dilakukan dengan kolom yang telah dipasangkan dengan 

sensor kapasitansi 32-channel, dan terdapat 8 level di collection zone. 
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5. Parameter tetap pada penelitian ini meliputi waktu conditioning selama 

10 menit, dosis kolektor (methyl ester sulfonate) 40 ppm, persentase 

solid 20%, dan laju alir 2,5 L/m. 

6. Analisis kadar dilakukan dengan metode grain counting dan 

perhitungan butir dilakukan dengan software ImageJ 1.53t. 

 

1.5 Sistematika Penulisan 

 Sistematika penulisan skripsi ini terbagi menjadi lima bab yang masing-

masing memiliki fokus dan tujuan tersendiri. Bab I dalam skripsi ini terdiri dari 

latar belakang penelitian, identifikasi masalah, tujuan penelitian, batasan masalah, 

dan sistematika penulisan. Bab II menyajikan tinjauan pustaka yang mencakup 

teori-teori yang mendasari penelitian ini. Bab III menjelaskan metode penelitian 

yang mencakup diagram alir penelitian, alat dan bahan yang digunakan, serta 

prosedur yang diikuti untuk mendapatkan data. Bab IV berisi tentang analisis dan 

pembahasan data yang diperoleh selama penelitian. Bab V yang merupakan 

kesimpulan dan saran. Terakhir, merupakan lampiran-lampiran penunjang serperti 

perhitungan, serta dokumentasi penelitian.  
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BAB II 

TINJAUAN PUSTAKA 

 

 

2.1 Pasir Kuarsa  

Pasir kuarsa adalah hasil dari proses pelapukan batuan yang mengandung 

silikon dioksida (SiO2). Proses pembentukan pasir kuarsa melibatkan beberapa 

tahap, yaitu pelapukan batuan, transportasi oleh air dan angin, serta sedimentasi. 

Selama proses ini, batuan tersebut hancur menjadi butiran pasir yang kemudian 

terbawa oleh aliran air atau tiupan angin hingga akhirnya terendapkan di tepi laut, 

danau, dan sungai. Pasir kuarsa yang terbentuk melalui proses ini tidak pernah 

ditemukan dalam keadaan murni di alam. Pasir kuarsa ini tercampur dengan 

lempung atau mineral lainnya seperti limonit, magnetit, dan zirkon. Hal ini terjadi 

karena selama proses transportasi dan pengendapan, pasir kuarsa sering kali 

membawa serta berbagai material pengotor. Berdasarkan hal tersebut, kemurnian 

dari pasir kuarsa tergantung pada proses pembentukan dan kondisi lingkungan di 

sekitarnya  [1]. 

 

2.2 Silikon Karbida 

Silikon karbida (SiC) atau Carborundum adalah senyawa keramik non-

oksida yang terbuat dari silikon (Si) dan karbon (C). Material ini memiliki ikatan 

kovalen yang sangat kuat antara atom silikon dan karbon, yang memberikan sifat 

mekanik dan termal yang luar biasa, seperti titik leleh yang sangat tinggi, modulus 
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elastisitas yang tinggi, serta ketahanan terhadap suhu ekstrem dan korosi. Dengan 

konduktivitas termal yang sangat baik dan ekspansi termal yang rendah, SiC juga 

ideal untuk aplikasi yang melibatkan pembuangan panas.  SiC digunakan dalam 

berbagai industri, terutama dalam elektronika sebagai semikonduktor untuk 

perangkat daya bertegangan tinggi, seperti dioda dan transistor yang beroperasi 

pada suhu tinggi dan frekuensi tinggi. Selain itu, SiC juga digunakan dalam bidang 

optoelektronik, seperti pada LED (Light Emitting Diode) dan detektor cahaya, 

karena sifat optiknya yang dipengaruhi oleh struktur kristalnya yang bervariasi, 

seperti kubik, hexagonal, dan politip. Keunggulan lainnya adalah kekerasannya 

yang tinggi, menjadikannya bahan abrasif yang efektif dan penguat dalam komposit 

untuk meningkatkan kekuatan dan ketahanan suhu tinggi. Sifat permukaannya, 

yang dipengaruhi oleh atom Si dan C, membuat SiC lebih reaktif secara kinetik dan 

berguna dalam berbagai aplikasi, mulai dari abrasif hingga teknologi nuklir [2].  

 

2.3 Flotasi  

Pada proses pengolahan mineral, flotasi merupakan salah satu teknik pada 

proses konsentrasi untuk memisahkan mineral berharga dengan pengotornya 

berdasarkan sifat permukaannya yaitu hydrophobic (tidak suka air) dan hydrophilic 

(suka air). Prinsip kerja flotasi yaitu dengan mengangkut partikel yang bersifat 

hydrophobic (tidak suka air) dengan gelembung udara sebagai konsentrat, dan 

partikel yang bersifat hydrophilic (suka air) akan mengendap di bawah permukaan 

dan dinyatakan sebagai tailing. Terdapat dua gaya yang berperan pada flotasi, yaitu 

gaya gravitasi dan gaya apung. Gaya gravitasi menyebabkan partikel hydrophilic 
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bergerak ke bawah menuju dasar tangki, sedangkan gaya apung menyebabkan 

gelembung udara yang membawa partikel hydrophobic bergerak ke atas menuju 

permukaan. Feed yang akan diolah berupa pulp yang dimasukkan ke dalam sel 

flotasi. Tangki untuk flotasi dilengkapi dengan impeller yang berfungsi sebagai 

agitator (pengaduk). Impeller ini berputar untuk mengaduk pulp dan menyatu 

dengan pipa yang menginjeksi udara ke dalam tangki. Proses pengadukan ini 

menghasilkan gelembung udara yang tersebar merata dalam pulp. Konsentrat yang 

telah terapung bersama buih akan ditampung pada bagian launder, yaitu bagian 

tangki yang dirancang untuk mengumpulkan buih pembawa mineral berharga. 

Sementara itu, partikel-partikel hydrophilic akan mengendap menjadi tailing. 

Proses flotasi juga melibatkan penggunaan reagen kimia seperti kolektor, dan 

frother untuk memodifikasi sifat permukaan mineral. Kolektor digunakan untuk 

meningkatkan hidrofobisitas mineral berharga, frother untuk menghasilkan dan 

menstabilkan buih [3][4].  

 

Gambar 2.1 Mekanisme Flotasi [3] 
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2.4 Flotasi Kolom 

Pemisahan mineral berharga dari material pengotor tidak optimal dalam sel 

mekanis konvensional. Flotasi kolom ditemukan pada awal tahun 1960-an sebagai 

alternatif yang lebih baik dibandingkan flotasi konvensional. Flotasi kolom 

memiliki beberapa keunggulan utama, termasuk pemulihan mineral yang lebih baik 

dengan kadar yang lebih tinggi, serta biaya modal dan operasional yang lebih 

rendah. Desain kolom yang bervariasi digunakan di seluruh dunia untuk memenuhi 

kebutuhan pemisahan mineral [5].  

Perbedaan mendasar antara mesin flotasi kolom dan flotasi konvensional 

terletak pada desain dan mekanisme operasinya. Flotasi konvensional umumnya 

menggunakan tangki persegi panjang yang dangkal dengan agitasi mekanik yang 

kuat untuk mencampurkan pulp dan udara. Sebaliknya, flotasi kolom mengadopsi 

desain silinder yang tinggi dengan aliran internal yang lebih terkontrol. Flotasi 

kolom tidak menggunakan agitasi, namun memanfaatkan prinsip aliran berlawanan 

antara partikel mineral dan gelembung udara. Gelembung udara diinjeksikan dari 

dasar kolom melalui sparger, menciptakan zona-zona yang berbeda di dalam kolom, 

yaitu collection zone, dan froth zone. Semua zona yang ada pada flotasi ini 

memungkinkan terjadinya interaksi yang lebih efisien antara partikel mineral dan 

gelembung udara, sehingga meningkatkan selektivitas dan kapasitas pemisahan. 

Selain itu, penggunaan wash water pada flotasi kolom membantu membersihkan 

buih dari partikel pengotor, menghasilkan konsentrat dengan kadar yang lebih 

tinggi. Desain kolom yang sederhana dan minim komponen bergerak juga 

mengurangi biaya perawatan dan meningkatkan keandalan operasi [6]. 
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Gambar 2.2 Skema Flotasi Kolom [6] 

 

Gambar 2.2 menunjukkan skema flotasi kolom. Umumnya tangki flotasi 

kolom terdiri dari feed inlet, wash water, column tank, sparger, dan discharge valve. 

Bagian feed inlet ini merupakan bagian untuk tempat masuknya umpan atau feed. 

Lalu bijih akan mengalir secara berlawanan arah dengan gelembung udara yang 

dihasilkan sparger. Bagian wash water berfungsi sebagai bagian yang akan 

dialirkan air dari atas kolom untuk meningkatkan drainase sehingga partikel 

hydrophilic akan tertinggal dalam air yang akan dikeluarkan sebagai tailing. 

Sementara partikel hydrophobic akan melekat pada gelembung dan bergerak ke atas 

kolom membentuk forth zone menuju concentrate outlet dimana bagian ini 

merupakan bagian untuk keluarnya konsentrat. Sebagian wash water bergerak 
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kebawah melewati froth zone membawa partikel gangue. Interaksi partikel dengan 

gelembung udara berlangsung pada collection zone [7]. Pada flotasi kolom, terdapat 

2 zona yaitu [8]: 

1. Collection zone 

Zona ini merupakan zona terjadinya interaksi antar gelembung udara 

dengan partikel untuk memisahkan konsentrat dan pengotornya. 

2. Froth zone 

Pada zona ini, seringkali mineral pengotor terbawa naik ke permukaan 

karena menempel pada konsentrat. Akan tetapi pada zona ini terdapat wash 

water yang dapat menghilangkan pengotor yang tidak diinginkan pada froth 

zone. 

 

2.5 Kolektor  

 Kolektor merupakan reagen yang pada penggunaannya membuat mineral 

menjadi bersifat hydrophobic (tidak suka air), sehingga mineral tersebut dapat 

menempel pada gelembung. Kolektor membentuk lapisan tipis pada permukaan 

partikel yang dasarnya adalah lapisan hidrokarbon non-polar yang bersifat 

hydrophobic. Dengan adanya kolektor, sudut kontak partikel dengan gelembung 

udara meningkat, sehingga gelembung lebih mudah menempel pada permukaan 

partikel. Waktu untuk teradsorpsi nya reagen ini pada permukaan mineral disebut 

dengan conditioning period. Untuk mineral yang memang bersifat hydrophobic 

tetap membutuhkan kolektor untuk menghomogenkan sifat permukaan mineral. 

Dalam flotasi, satu atau dua campuran kolektor dapat digunakan. Kemudian salah 
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satunya biasa disebut promotor. Beberapa promotor flotasi, bila digunakan secara 

terpisah, menunjukkan efek flotasi yang sangat lemah. Kolektor dan promotor 

dapat terlihat sinergisme jika ada kolektor yang tepat [9]. 

Kolektor dapat menempel pada permukaan mineral melalui dua cara, yaitu 

chemisorption (membentuk ikatan kimia dengan permukaan mineral) dan physical 

adsoption (menempel pada permukaan mineral melalui gaya fisik). Dalam 

chemisorption, ion atau molekul dari larutan mengalami reaksi kimia dengan 

permukaan partikel mineral, sehingga dapat mengubah sifat permukaan tersebut 

secara selektif karena hanya atom-atom tertentu yang terlibat dalam ikatan kimia 

ini. Sebaliknya, physisorption terjadi ketika ion atau molekul dari larutan terikat 

menempel pada permukaan partikel mineral melalui daya tarik elektrostatik atau 

ikatan Van der Waals. Physisorption kurang selektif jika dibandingkan 

chemisorption karena kolektor akan menempel pada permukaan apa pun yang 

memiliki muatan listrik atau tingkat hidrofobisitas yang sesuai [10]. 

 

2.6 Frother 

Frother adalah salah satu reagen dalam proses flotasi mineral yang berperan 

penting dalam membantu membentuk dan menstabilkan ukuran gelembung, 

meningkatkan dispersi udara dalam kolom, serta mengurangi koalesensi atau 

penyatuan gelembung [4]. Kehadiran buih yang stabil diperlukan untuk 

mengangkat atau membawa mineral berharga ke atas (froth zone). Namun, buih 

tidak boleh terlalu stabil karena buih yang terlalu stabil akan menyebabkan masalah 

dalam penanganannya. Frother merupakan senyawa permukaan aktif heteropolar 



 

13 

 

yang memiliki gugus polar hydrophillic dan gugus non-polar hydrophobic [7]. 

Umumnya, frother terbagi menjadi 3 kategori, yaitu alkohol alami (Methyl isobutyl 

carbinol, dan pine oil), alkohol sintesis (Polyethylene glycol, dan Propanol), dan 

formulasi khusus. Minyak pinus (pine oil) merupakan salah satu jenis frother yang 

termasuk ke dalam kategori frother alkohol alami. Keunggulan pada frother minyak 

pinus ini yaitu lebih ekonomis dibandingkan dengan frother lainnya. Menurut Lin 

dan [11], minyak pinus memiliki kemampuan yang lebih baik dalam 

mengapungkan partikel-partikel besar dibandingkan dengan frother jenis alkohol 

lainnya.  

Penambahan dosis frother pada proses flotasi kolom akan meningkatkan 

jumlah gelembung yang dihasilkan, dan memperbaiki distribusi gelembung secara 

merata di dalam kolom. Hasilnya, pembentukan froth menjadi lebih optimal dan 

stabil. Dalam konteks ini, froth yang yang baik akan membuat pemisahan partikel 

mineral berharga dari pengotornya dengan lebih efisien, tetapi juga meningkatkan 

kuantitas partikel mineral yang dapat terangkat ke froth zone [9]. Selain itu, 

peningkatan dosis frother mengurangi tegangan permukaan air, menghasilkan efek 

yang mengaktifkan gaya tegangan permukaan di sekitar gelembung. Gaya ini 

bertugas menjaga kestabilan gelembung, mencegahnya pecah, dan memperpanjang 

umur froth. Stabilitas gelembung yang tercapai merupakan faktor krusial dalam 

mengoptimalkan transportasi partikel mineral ke permukaan dan meningkatkan 

efisiensi keseluruhan proses flotasi. Cara kerja frother adalah dengan menurunkan 

tegangan permukaan air, sehingga gelembung yang dihasilkan lebih stabil atau 
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cenderung tidak mudah pecah dengan menciptakan lapisan pada permukaan 

gelembung udara [12]. 

 

2.7 Kapasitor 

Kapasitor merupakan alat atau komponen elektronik yang mampu untuk 

menyimpan muatan listrik. Kemampuan ini diukur dengan sebuah besaran yang 

disebut kapasitansi dengan satuan Farad (F). Kapasitansi sebuah kapasitor adalah 

perbandingan muatan yang dapat disimpan dengan beda potensial. Semakin besar 

kapasitansi sebuah kapasitor, semakin besar pula muatan listrik yang dapat 

disimpan oleh kapasitor tersebut. Struktur sebuah kapasitor umumnya terdiri dari 

dua pelat metal atau elektroda yang dipisahkan oleh suatu bahan dielektrik. Bahan 

dielektrik ini adalah bahan isolator yang diselipkan di antara pelat-pelat elektroda 

tersebut. Dielektrik memiliki peran penting karena menentukan kapasitansi dan 

kemampuan kapasitor untuk menyimpan muatan listrik. Masing-masing bahan 

dielektrik memiliki karakteristik khusus yang mempengaruhi kinerja dan aplikasi 

kapasitor dalam rangkaian elektronik [14].  

Prinsip kerja kapasitor adalah ketika kedua elektroda diberi tegangan listrik, 

maka muatan positif akan mengumpul pada salah satu elektroda. Sedangkan untuk 

muatan negatif, mengumpul pada elektroda lainnya. Muatan positif tidak dapat 

mengalir ke elektroda negatif, begitu juga sebaliknya, karena kedua elektroda 

tersebut dipisahkan oleh bahan dielektrik yang tidak konduktif. Muatan listrik ini 

akan tetap tersimpan selama tidak ada konduksi di antara ujung-ujung kaki 

kapasitor. Gambar 2.3, terlihat salah satu jenis kapasitor yaitu pelat sejajar. Dalam 
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konteks kapasitansi, ε biasanya mengacu pada permitivitas total dari bahan 

dielektrik yang berada di antara pelat-pelat kapasitor. Permitivititas total ini adalah 

hasil kali dari konstanta dielektrik ruang hampa ε0 dan konstanta dielektrik relatif 

εr dari bahan tersebut. A merupakan luas permukaan kapasitor, dan d merupakan 

jarak antar kapasitor. Jika ada stimulus atau fenomena fisik yang menyebabkan 

perubahan dalam salah satu dari salah satu εr, A, atau d, maka nilai kapasitansinya 

juga akan berubah [15]. 

 

Gambar 2.3 Struktur Fisik Kapasitor Pelat Sejajar [15] 

 

2.8 Kapasitansi 

Kapasitansi adalah kemampuan suatu kapasitor untuk menampung muatan 

listrik. Coulomb menemukan bahwa 1 coulomb setara dengan 6.25 x 1018 elektron. 

Kemudian, Michael Faraday mengajukan bahwa sebuah kapasitor akan memiliki 

kapasitansi 1 farad jika dapat menampung muatan sebesar 1 coulomb saat diberi 

tegangan 1 volt. Dengan demikian, farad merupakan satuan yang mengukur 

seberapa besar kapasitas suatu kapasitor untuk menampung muatan listrik. 

Persamaan matematis kapasitansi dapat ditulis sebagai berikut [15]: 

! = #. %  ………………………………(2.1) 



 

16 

 

 

Dimana: 

Q = Muatan elektron dalam C (Columbs) 

C = Nilai kapasitansi dalam F (Farad) 

V = Besar tegangan dalam V (volt) 

 

2.9 Kapasitometer  

Kapasitometer adalah alat uji elektronik yang digunakan untuk mengukur 

nilai kapasitansi suatu kapasitor [16]. Prinsip kerja kapasitometer ini adalah 

mengukur kapasitansi suatu material dengan mengubahnya menjadi sinyal 

tegangan listrik menggunakan rangkaian C-V (capacitance-to-voltage). Rangkaian 

C-V bekerja dengan mengubah arus yang dihasilkan oleh kapasitansi material 

menjadi tegangan listrik menggunakan operational amplifier (op-amp), resistor 

feedback (Rf ), dan kapasitor feedback (Cf ) sebagai transduser. Dalam op-amp, arus 

yang masuk dan keluar bernilai sama (&! = &"), sehingga tegangan keluaran (Vo) 

dapat merepresentasikan nilai kapasitansi objek (Cx) yang dihitung berdasarkan 

tegangan injeksi sinusoidal (Vinj), frekuensi angular (ω) serta nilai Rf  dan Cf. 

Sehingga tegangan yang merepresentasikan pengukuran kapasitansi didapat seperti 

Persamaan 2.2 [17]:  

%# =	−
$!%"&# &!'
$!! (&!)

………………….…… (2.2) 
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Gambar 2.4 Kapasitometer CAP 3201 2CH C-Tech Labs Edwar 

Technology 

 

2.10 Sensor Kapasitif 

Sensor kapasitif merupakan jenis sensor yang mengubah stimulus fisik 

menjadi perubahan dalam besaran listrik, di mana besaran ini disebut dengan 

kapasitansi. Sensor kapasitif bekerja dengan mengukur perubahan dalam 

kemampuan sensor untuk menyimpan muatan listrik. Perubahan ini dapat terjadi 

karena beberapa faktor fisik, di antaranya yaitu perubahan jarak antar lempeng, 

perubahan luas penampang, dan perubahan volume dielektrikum. Sensor kapasitif 

dapat digunakan untuk berbagai pengukuran, seperti perpindahan linear dan 

rotasional, tekanan, gaya, torsi, akselerasi, kelembaban relatif, suhu, dan tingkat 

ketinggian cairan. Penggunaan sensor kapasitif juga memiliki kelemahan, di mana 

sensor ini dapat menimbulkan kesalahan karena adanya kapasitansi parasitik. 

Kapasitansi parasitik adalah kapasitansi yang tidak diinginkan atau sulit dihindari 

yang muncul pada komponen atau rangkaian elektronik [19]. 

 

2.11 Grain Counting 

Grain counting adalah metode yang umum digunakan dalam menentukan 

kadar mineral dengan memisahkan mineral berdasarkan sifat fisiknya yang berbeda. 
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Proses grain counting sangat penting untuk mengetahui hasil recovery atau kadar 

dari proses tersebut. Proses analisis mineral menggunakan metode ini biasanya 

dilakukan secara manual dengan melibatkan penggunaan mikroskop binokuler dan 

peralatan tambahan seperti blok millimeter dengan ukuran tertentu [6].  

Meskipun telah banyak digunakan, metode grain counting manual memiliki 

kelemahan, terutama dalam hal mendeteksi, kecepatan dalam menghitung butiran 

mineral kecil, sehingga kurang efisien. Seiring kemajuan teknologi, banyak 

metode-metode konvensional yang diciptakan untuk menghitung jumlah butir 

seperti deteksi infra merah (infrared detection), sound collision, dan image analysis. 

Metode deteksi infra merah dapat beradaptasi dengan partikel sesuai dengan ukuran 

dan bentuk yang berbeda, hasil akurasinya tinggi, namun memiliki kekurangan 

biaya yang tinggi dan apabila butir yang jatuh terlalu cepat, kemungkinan tidak 

akan masuk dalam perhitungan karena butiran dianggap saling menghalangi. Lalu, 

metode sound collision memiliki akurasi tinggi namun mudah terpengaruh oleh 

faktor eksternal, dan pemasangan awalnya rumit. Metode image analysis lebih 

sederhana dan biayanya rendah, tetapi algoritma segmentasi gambar memiliki 

kompleksitas teknis yang substansial [19].  

 

2.12 ImageJ 

ImageJ merupakan software analisis citra yang bersifat fleksibel dan dapat 

diterapkan dalam berbagai bidang, termasuk ilmu material, biologi, dan medis. 

Software ini memungkinkan berbagai jenis analisis citra, mulai dari pengukuran 

sederhana, seperti luas dan diameter partikel, hingga analisis yang lebih kompleks 



 

19 

 

seperti segmentasi gambar dan perhitungan jumlah partikel. Fleksibilitas ImageJ 

memungkinkan penyesuaian terhadap berbagai jenis sampel serta pengembangan 

algoritma khusus sesuai dengan kebutuhan penelitian. Selain itu, ImageJ bersifat 

open-source, sehingga pengguna dapat mengembangkan plugin dan skrip untuk 

menyesuaikan dengan kebutuhan spesifik penelitian. Berbagai alat dan fitur yang 

tersedia memungkinkan pemrosesan, analisis, serta kuantisasi data gambar secara 

efisien, menjadikannya salah satu perangkat lunak analisis citra yang banyak 

digunakan dalam penelitian [20]. 
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BAB III 

METODE PENELITIAN 

 

 

3.1 Diagram Alir Penelitian 

Pada Gambar 3.1 di bawah ini terdapat skema metode penelitian yang telah 

dilakukan. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SiC dan SiO2 

Grinding dan Sieving 

Penimbangan massa SiC 20 gram 

dan SiO2 80 gram 

 

Melakukan kalibrasi pada 

kapasitometer 

Conditioning 10 menit: 

Pine oil 20 ppm, 30 ppm, 40 ppm, 

dan 50 ppm 

Metil ester sulfonat 40 ppm 

Ukuran partikel: -100+150#, -

150+200#, -200+230#, dan -230# 

 

Persiapan rangkaian sensor  

Pengecekan suhu ruangan 

dan warm up kapasitometer 

Aerasi selama 1000 detik dengan 

laju alir udara 2,5 L/menit 

Monitoring menggunakan 

kapsitometer yang direkam 

oleh video recorder 
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Gambar 3.1 Diagram Alir Penelitian  

 

3.2 Alat dan Bahan 

3.2.1 Alat 

Berikut merupakan alat yang digunakan dalam penelitian. 

1. Chopper merek Miyako. 

Konsentrat Tailing 

Grain counting 

Recovery Sinyal kapasitansi 

Data Literatur 

Pengeringan dan penimbangan 

Analisis dan pembahasan 

Kesimpulan 
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2. Ember. 

3. Gelas beker 500 mL merek IWAKI. 

4. Hand mixer merek Miyako HM-620. 

5. Hand sprayer. 

6. Kabel konektor channel 18 dan 19. 

7. Kaca arloji. 

8. Kaca pembesar. 

9. Kamera telepon seluler. 

10. Kapasitometer CAP 3201 2CH C-Tech Labs Edwar Technology. 

11. Kolom flotasi. 

12. Kompresor merek Michelin. 

13. Nampan. 

14. Neraca digital merek LUCKY seri NE. 

15. Oven Kris 16 Ltr. 

16. Pipet.  

17. Sensor ECVT 32CH C-Tech Labs Edwar Technology. 

18. Sieve 100#, 150#, 200#, dan 230# merek KZM. 

19. Stabilizer 3000 VA merek VYBA. 

 

3.2.2 Bahan 

Berikut merupakan bahan yang dibutuhkan untuk penelitian. 

1. Air keran. 

2. Kolektor yaitu metil ester sulfonat PT. Wilmar Nabati Indonesia. 
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3. Frother yaitu pine oil 0,1 M poduksi Rendys Chemical. 

4. SiC. 

5. SiO2. 

 

3.3 Prosedur Penelitian 

3.3.1  Preparasi Sampel 

Pada tahap preparasi sampel, bahan yang digunakan dalam 

penelitian dipersiapkan, yaitu pasir SiC dan SiO2. Tahapan preparasi ini 

dimulai dari penggerusan SiC dan SiO2 menggunakan chopper selama 

kurang lebih 3-10 menit untuk mengecilkan ukuran partikel. Setelah itu, SiC 

dan SiO2 akan melalui proses sieving untuk menyamaratakan dan 

menyesuaikan ukuran partikel yang akan digunakan. Terdapat 4 variasi 

ukuran sieve yaitu 100#, 150#, 200#, dan 230#. Fraksi ukuran yang 

digunakan dalam penelitian ini adalah -100+150#, -150+200#, -200+230#, 

dan -230#.  

3.3.2  Preparasi Sensor Flotasi 

 Sebelum memulai proses flotasi, sistem sensor kapasitansi 

dipersiapkan terlebih dahulu. Kapasitometer CAP 3201 2CH C-Tech Labs 

Edwar Technology ke 2-channel disambungkan ke sensor ECVT pada 

channel-18 dan channel-19 (level 4) menggunakan kabel konektor. Setelah 

itu, kapasitometer dihubungkan ke stabilizer yang terhubung ke sumber 

listrik. Ketika seluruh rangkaian sensor selesai dihubungkan, stabilizer dan 

kapasitometer dinyalakan untuk proses warm up, di mana proses ini 
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dilakukan selama kurang lebih 1 menit. Setelah itu, kapasitometer 

dikalibrasi untuk menentukan pengaturan set CF yang paling mendekati 

nilai kapasitansi dari kapasitor. Set CF pada kapasitometer mengatur 

sensitivitasnya, di mana semakin tinggi nilai set CF, semakin tinggi pula 

sensitivitasnya, namun rentang kapasitansi yang dapat diukur semakin 

rendah. Kalibrasi dilakukan menggunakan kapasitor 1 pF dan 4 pF pada 

seluruh nilai set CF kapasitometer. Set CF 45 pF digunakan untuk setiap 

monitoring flotasi kolom karena mendekati nilai kapasitor 1 pF dan 4 pF. 

3.3.3 Proses Monitoring dan Flotasi Kolom  

Setelah perangkat-perangkat sensor flotasi dirangkai sesuai dengan 

Gambar 3.2, yang menunjukkan stabilizer (9) terhubung dengan 

kapasitometer (8) dan kapasitometer dihubungkan ke badan sistem sensor 

flotasi 2-channel, langkah selanjutnya adalah mempersiapkan bahan-bahan 

yang akan digunakan. Bijih yang telah melalui proses preparasi akan 

dibentuk menjadi slurry. Pada penelitian ini, SiC digunakan sebagai partikel 

hydrophobic yang akan terangkat kepermukaan bersama gelembung dan 

SiO2 sebagai partikel hydrophilic yang akan mengendap menjadi tailing. 

Ada dua tahapan dalam proses flotasi yaitu conditioning dan aerasi. Proses 

awal conditioning dilakukan dengan mencampurkan air keran 400 mL 

dengan SiC 20 gram, SiO2 80 gram sehingga diperoleh 500 mL slurry 

dengan 20% solid. Variasi ukuran partikel SiC dan SiO2 yang digunakan 

yaitu 100+150#, -150+200#, -200+230#, dan -230# dengan variasi dosis 

frother (pine oil) 50 ppm. Sementara untuk pengambilan data pada variasi 
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dosis frother menggunakan ukuran partikel -230# dengan konsentrasi 

frother 20 ppm, 30 ppm, 40 ppm, dan 50 ppm. Kolektor (metil ester 

sulfonat) 40 ppm juga di tambahkan agar partikel responsif terhadap proses 

flotasi. Proses conditioning dilakukan selama 10 menit menggunakan hand 

mixer. Setelah slurry siap, selang kompresor (4) pada gambar 3.2 

dihubungkan ke bagian bawah alat flotasi. Lalu, air dituang ke dalam kolom 

flotasi melalui bagian (1) mendekati tempat masuknya feed. Atur laju alir 

udara menjadi 2,5 L/menit melalui flowmeter (3). Setelah proses 

conditioning selesai dilakukan, dilakukan proses aerasi. 

 

Gambar 3.2 Rangkaian Sistem Flotasi 
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Gambar 3.3 Skema Monitoring Flotasi Kolom 

 

 

Gambar 3.4 Slurry 
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Proses aerasi diawali dengan membuka katup selang konsentrat dan 

tailing yang telah dimasukkan ke dalam ember (sebagai wadah penampung). 

Lalu slurry dituangkan secara konstan melaui feeder (2). Pengambilan 

konsentrat dilakukan selama 1000 detik (16 menit 40 detik) dengan 

pembagian waktu 9 interval yaitu 2 menit 30 detik, 3 menit, 3 menit 30 detik, 

4 menit, 6 menit, 8 menit, 10 menit, 13 menit 40 detik, dan 16 menit 40 

detik. Ember untuk menampung konsentrat digunakan diganti secara 

berurutan sesuai dengan waktu interval. Saat proses pemisahan berlangsung, 

monitoring dilakukan dengan merekam kapasitometer oleh video recorder 

manual yang telah diposisikan di depan kapasitometer (8) hingga proses 

aerasi selesai. Hasil rekaman tersebut merupakan nilai kapasitansi selama 

proses aerasi berlangsung, di mana data yang terekam akan dicatat dan 

dihitung melalui Microsoft Excel. Setelah proses aerasi selesai, konsentrat 

yang didapat akan dikeringkan menggunakan oven pada suhu 100ºC dengan 

kisaran waktu 30-40 menit. Selanjutnya, dilakukan proses coning and 

quartering dan grain counting pada setiap konsentrat yang telah 

dikeringkan sesuai dengan waktu interval. 

3.3.4 Coning and Quartering 

Proses coning and quartering dilakukan untuk mendapat sampel 

konsentrat yang dapat mewakili secara keseluruhan. Langkah awal untuk 

melakukan coning and quartering yaitu dengan membuat penumpukan dari 

konsentrat yang telah didapat dari masing-masing variasi hingga berbentuk 

kerucut atau cone pada permukan yang datar. Hasil dari coning dapat dilihat 
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pada gambar 3.5. Setelah itu, konsentrat berbentuk cone tersebut diratakan 

dan dibagi menjadi empat bagian. Dari empat bagian tersebut, hanya dua 

bagian berlawanan yang diambil untuk menghindari bias. Proses ini 

dilakukan berulang hingga mendapat jumlah sampel yang cukup. 

 

Gambar 3.5 Coning and Quartering 

 

3.3.5 Grain Counting 

Konsentrat yang telah melalui proses coning and quartering 

selanjutnya akan melalui proses grain counting untuk mengetahui recovery. 

Sampel konsentrat diambil dengan perkiraan jumlah yang cukup, lalu 

ditebar ke 9 petak secara merata. Setelah itu, diperlukan kaca pembesar 

untuk melihat partikel dengan lebih jelas. Secara teknis, partikel yang 

terlihat melalui kaca pembesar akan difoto per petak menggunakan kamera. 

Petak yang digunakan untuk grain counting adalah petak 1, 3, 5, 7, dan 9, 

seperti pada Gambar 3.6. Hasil tangkapan partikel oleh kamera kemudian 

dianalisis menggunakan software bernama 'ImageJ', di mana software ini 

mampu mendeteksi jumlah dari partikel SiC dan SiO2.  



 

29 

 

 

Gambar 3.6 Grid untuk Grain Counting 

 

Tahapan untuk menggunakan software ‘ImageJ’, dimulai dari 

membuka software 'ImageJ' dan pilih menu 'File,' lalu klik 'Open' untuk 

memilih gambar atau foto konsentrat yang ingin dianalisis. Selanjutnya, 

pilih 'Image' dan klik 'Adjust,' kemudian pilih 'Color Threshold' untuk 

mengatur parameter 'Hue,' 'Saturation,' dan 'Brightness' sesuai dengan 

kebutuhan analisis gambar. Setelah itu, buka menu 'Process,' pilih 'Binary,' 

kemudian klik 'Make Binary' dan 'Convert to mask' untuk membuat partikel 

tampak berwarna putih, sementara latar belakang menjadi hitam. Jika 

terdapat lubang pada objek atau latar belakang, pilih 'Binary,' kemudian klik 

'Fill Holes' untuk mengisi butiran yang terdeteksi tersebut. Untuk 

memisahkan partikel-partikel yang berdempetan atau bersentuhan, gunakan 

opsi 'Watershed' pada menu 'Binary.' Terakhir, pilih 'Analyze,' klik 'Analyze 

Particles' untuk menghitung jumlah partikel yang terdapat pada area yang 

telah terseleksi, sehingga didapatkan hasil analisis jumlah partikelnya. 
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BAB IV 

HASIL DAN PEMBAHASAN 

 

 

4.1 Karakterisasi SiC 

Karakterisasi bijih silikon karbida (SiC) dalam penelitian ini dilakukan 

menggunakan metode X-Ray Diffraction (XRD) agar unsur dan fase yang terdapat 

dalam sampel diketahui. Data hasil pengujian XRD selanjutnya diolah 

menggunakan software Profex versi 5.2.5, yang merupakan software open-source 

yang banyak digunakan dalam analisis pola difraksi. Pola difraksi yang diperoleh 

dari pengujian XRD dibandingkan dengan database yang ada di dalam perangkat 

lunak tersebut melalui metode Search and Match. Metode ini bertujuan untuk 

mencocokkan puncak-puncak difraksi yang dihasilkan dari sampel dengan pola 

difraksi fase kristalin yang tersimpan dalam database.  

 

Gambar 4.1 Hasil Pengujian XRD Conto SiC  
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Proses iterasi dilakukan sebanyak tiga kali untuk memastikan keakuratan 

fase yang teridentifikasi. Iterasi dilakukan secara bertahap, dan fase yang memiliki 

nilai Figure of Merit (FoM) tertinggi dipilih untuk dilakukan refinemen lebih lanjut. 

Nilai FoM yang rendah menunjukkan bahwa fase yang diidentifikasi memiliki 

kecocokan yang baik dengan data referensi, sedangkan nilai yang sangat tinggi 

menunjukkan ketidaksesuaian. Pada iterasi ketiga, ditemukan bahwa fase dengan 

nilai FoM tertinggi memiliki fraksi sebesar 0,00, yang menunjukkan bahwa fase 

tersebut sangat kecil atau tidak signifikan dalam data yang diukur. Hasil refinement 

ini mengonfirmasi bahwa sampel silikon karbida yang digunakan memiliki 

kemurnian yang sangat tinggi, dengan seluruh puncak difraksi yang teridentifikasi 

secara konsisten mencocokkan fase silikon karbida tanpa adanya indikasi fase lain 

yang signifikan [34]. Berdasarkan hasil ini, dapat disimpulkan bahwa bijih silikon 

karbida yang digunakan dalam penelitian ini memiliki kandungan mendekati 100% 

kemurnian, sehingga dapat digunakan.  

 

4.2 Grain Counting  

 Grain counting adalah metode analisis yang digunakan untuk menghitung 

jumlah butiran mineral dalam sampel, yang dalam penelitian ini diterapkan untuk 

menentukan kandungan konsentrat bijih silikon karbida (SiC) dan silikon dioksida 

(SiO2). Metode ini dilakukan melalui analisis gambar digital menggunakan 

software open-source ImageJ 1.53t, yang memungkinkan pengolahan gambar 

secara otomatis untuk menghitung jumlah butiran berdasarkan citra yang dihasilkan. 

Untuk memvalidasi keakuratan penggunaan ImageJ dalam metode grain counting, 
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dilakukan perbandingan antara metode grain counting secara manual dengan 

menggunakan ImageJ. Gambar 4.2 merupakan sampel konsentrat yang telah 

didapat dari hasil flotasi. Jumlah butir dari konsentrat telah dihitung secara manual 

dengan bantuan kaca pembesar menunjukkan bahwa sampel konsentrat 

mengandung 46 butir SiC dan 335 butir SiO2. 

 

Gambar 4.2 Sampel Konsentrat 

 

Selanjutnya, dilakukan analisis menggunakan ImageJ yang hasilnya dapat 

dilihat pada Gambar 4.3. Dari analisis menggunakan ImageJ, terdeteksi 48 butir 

SiC dan 338 butir SiO2. Meskipun terdapat sedikit perbedaan antara hasil 

perhitungan manual dan hasil dari ImageJ, selisih yang dihasilkan masih dalam 

batas wajar. Selisih yang kecil ini menunjukkan bahwa ImageJ cukup akurat dan 

dapat diandalkan sebagai teknologi untuk metode grain counting dalam penelitian 

ini. Dengan demikian, validasi ini menegaskan bahwa software ImageJ dapat 

digunakan sebagai alternatif yang efisien dan tepat dalam menghitung jumlah butir 

mineral secara otomatis. 
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Gambar 4.3 Hasil Analisis Sampel Konsentrat dengan ImageJ. a) SiC, b) SiO2 

 

4.3  Pengaruh Ukuran Partikel Terhadap Recovery dan Kapasitansi 

Ukuran partikel dari feed merupakan salah satu hal yang berperan penting 

dalam menentukan seberapa baik proses flotasi dapat berlangsung. Ukuran partikel 

dapat memengaruhi kemampuan partikel untuk mengapung (floatability). Hal ini 

berarti, semakin kecil atau semakin halus ukuran partikelnya, kemungkinan partikel 

untuk mengapung dalam proses flotasi akan semakin baik. Sebaliknya, partikel 

yang lebih besar atau lebih kasar memiliki kemungkinan kemampuan untuk 

mengapung yang kurang baik [25]. Pada penelitian ini partikel SiC dan SiO2 

sintetik diayak menggunakan sieve agar ukuran partikel sesuai dengan variasi yang 

akan digunakan, yaitu -100+150#, -150+200#, -200+230#, dan -230#. Dosis frother 

yang digunakan pada variasi ukuran partikel ini adalah 50 ppm dengan dosis 

kolektor 40 ppm. 
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Gambar 4.4 Kurva Hubungan Recovery dan Kapasitansi terhadap Waktu dari 

Variasi Ukuran Partikel a) Recovery, b) Kapasitansi 

 

Gambar 4.4 menunjukkan recovery tertinggi dihasilkan oleh partikel paling 

halus, yaitu -230#, dengan nilai recovery sebesar 31,28% dan kapasitansi 26,8 pF. 

Sebaliknya, recovery terendah diperoleh dari partikel paling kasar, yakni -

100+150#, dengan nilai recovery 2,17% dan kapasitansi 24,6 pF. Pada ukuran 

partikel -150+200#, recovery yang diperoleh sedikit lebih tinggi, yaitu 2,35%, 

namun kapasitansinya menurun menjadi 24,1 pF. Lalu, pada ukuran partikel -

200+230#, recovery tercatat sebesar 8,93% dengan kapasitansi 23,7 pF. Perbedaan 

pergerakan tren antara partikel yang paling halus, yaitu -230#, dan partikel yang 

paling kasar, yaitu -100+150#. Di lihat pada rentang waktu 0-200 detik, ukuran 

partikel -230# memiliki laju recovery yang lebih cepat dari ukuran partikel -

100+150#. Bentuk tren kapasitansi yang dihasilkan dari kedua ukuran partikel 

tersebut cenderung mirip, namun tren kapasitansi dari ukuran partikel -230# 

cenderung lebih tinggi. Untuk rentang waktu 200-1000 detik, ukuran partikel -230# 

masih mengalami kenaikan yang signifikan hingga di waktu 240 detik sebelum 
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akhirnya tren bergerak mendatar. Sementara untuk ukuran partikel -100+150# 

dalam rentang waktu tersebut sudah tidak mengalami kenaikan yang signifikan 

sejak 210 detik. Berdasarkan hal tersebut, ketika ukuran partikel semakin kecil, luas 

permukaan yang dapat berinteraksi dengan frother dan kolektor juga semakin besar, 

sehingga proses flotasi berjalan dengan lebih efisien, dilihat dari nilai recovery yang 

didapat semakin tinggi. Ukuran partikel kasar cenderung kurang bisa menempel 

dengan baik pada gelembung, sehingga hasil flotasi kurang baik dibandingkan 

dengan ukuran partikel yang lebih halus. Namun, ukuran partikel yang sangat halus 

juga kurang baik untuk proses flotasi karena massa dan inersianya yang kecil [30]. 

Dari data recovery dan kapasitansi yang diperoleh, dapat dinyatakan bahwa sensor 

berbasis kapasitansi, melalui sinyal kapasitansi yang didapat, mampu untuk 

mengetahui performa metalurgis.  

 

Gambar 4.5 Kurva Hubungan Kapasitansi Terhadap Recovery pada Ukuran 

Partikel -200+230# 

 

Pada variasi ukuran partikel, dilakukan pendekatan matematis dengan 

polinomial orde 4, karena hasil regresi mendekati 1. Pendekatan matematis ini 
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dapat memprediksi nilai recovery berdasarkan kapasitansi. Persamaan ini dapat 

membantu menjelaskan bagaimana kapasitansi dapat digunakan untuk 

memperkirakan recovery. Ukuran partikel termasuk variabel bebas, yang artinya 

nilainya dapat diatur. Dalam hal ini, nilai recovery, sebagai variabel terikat, nilainya 

akan berubah sesuai dengan perubahan ukuran partikel nya. Kurva kapasitansi 

terhadap recovery pada Gambar 4.5 merupakan kurva variasi ukuran partikel -

200+230# yang menghasilkan Persamaan 4.1 dengan R² = 0,9822, di mana hal ini 

menunjukkan kedekatan model dan data aktualnya.  

y = -1×10
-5

x4 	−  0,0019x3 + 0,0789x
2
 −  0,3315x + 0,5651 …………………(4.1) 

 

Keterangan: 

y = Nilai recovery flotasi (%) 

x = Nilai kapasitansi (pF) 

 

4.4 Pengaruh Dosis Frother Terhadap Recovery dan Kapasitansi 

 Selama proses aerasi dalam flotasi kolom, gelembung-gelembung udara 

yang terbentuk tidak stabil dan mudah pecah ketika berinteraksi dengan partikel 

padat. Ketidakstabilan ini disebabkan oleh kontak antara gelembung dan partikel 

yang dapat menyebabkan gelembung pecah, sehingga dapat mengurangi efektivitas 

proses flotasi. Untuk menghindari masalah tersebut, diperlukan penambahan 

frother. Frother berfungsi untuk menurunkan tegangan permukaan, dan membantu 

membentuk buih (froth) yang lebih stabil. Dengan menggunakan frother, ukuran 

gelembung dapat dikendalikan dan stabilitas buih dapat ditingkatkan, sehingga 
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memungkinkan partikel-partikel mineral berharga untuk terangkat dengan lebih 

efisien ke permukaan. Stabilitas buih yang meningkat juga memudahkan pemisahan 

partikel mineral dari pengotornya, sehingga keberhasilan keseluruhan proses flotasi 

kolom dapat dicapai. Frother mampu untuk membuat gelembung stabil sehingga 

gelembung tidak mudah pecah dikarenakan cara kerja frother yang dapat 

membentuk lapisan tipis [33]. Pada penelitian ini variasi dosis frother digunakan 

untuk dapat menghasilkan perbedaan distribusi gelembung dan ketebalan froth 

(busa). Pine oil digunakan sebagai frother dalam penelitian ini, yang merupakan 

frother jenis alkohol berbentuk siklik sehingga mudah larut dalam air. Selain itu, 

pine oil mudah didapatkan dan juga lebih ekonomis dibanding dengan jenis frother 

lainnya. Variasi dosis frother yang digunakan pada penelitian ini yaitu 20 ppm, 30 

ppm, 40 ppm, dan 50 ppm dengan laju alir 2,5 L/m dan dosis kolektor sebagai 

variabel tetap yang digunakan yaitu 40 ppm. Dari proses monitoring flotasi kolom 

dengan variasi dosis frother yang telah dilakukan, didapatkanlah kurva recovery 

dan kapasitansi seperti Gambar 4.6 berikut.  

 

Gambar 4.6 Kurva Hubungan Recovery dan Kapasitansi terhadap Waktu dari 

Variasi Dosis Frother a) Recovery, b) Kapasitansi 
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Gambar 4.6 menunjukkan tren dari kurva recovery mulai mengalami 

peningkatan dari detik 0 hingga berada di waktu sekitar 360 detik (6 menit), setelah 

itu tren mulai mendatar hingga proses pengambilan konsentrat selesai. Untuk 

perolehan nilai kumulatif recovery pada dosis frother 20 ppm adalah 22,71% 

dengan kapasitansi 26,6 pF, nilai kumulatif recovery untuk 30 ppm adalah 66,26% 

dengan kapasitansi 27,27 pF, untuk kumulatif recovery 40 ppm adalah 80,25% 

dengan kapasitansi 26,91 pF, dan untuk kumulatif recovery 50 ppm adalah 31,28% 

dengan kapasitansi 26,8 pF. Berdasarkan analisis kurva recovery tersebut, hasil 

kumulatif recovery dan kapasitansi tertinggi dihasilkan pada variasi frother 40 ppm. 

Sementara untuk nilai recovery paling rendah dihasilkan oleh dosis frother 20 ppm. 

Jika keempat variasi dosis frother dibandingkan, terlihat bahwa pada 40 ppm, tren 

recovery dan kapasitansi mengalami peningkatan yang sangat signifikan dibanding 

tiga variasi dosis frother lainnya. Hal ini menunjukkan bahwa penambahan dosis 

frother dapat meningkatkan persentase recovery yang didapatkan. Akan tetapi, 

ketika dosis frother telah mencapai titik maksimum perolehan, maka untuk 

penambahan dosis frother akan menyebabkan penurunan nilai recovery karena 

sudah tidak memberi pengaruh yang berarti.  

Peningkatan dosis frother dapat meningkatkan stabilitas buih, namun jika 

dosisnya terlalu tinggi, buih yang sangat stabil dapat mengakibatkan entrainment 

non-selektif, di mana partikel hydrophilic yang berperan sebagai pengotor juga 

terangkat bersama partikel hydrophobic, sehingga efisiensi pemisahan menurun. 

Dosis frother 40 ppm memberikan keseimbangan yang lebih baik antara stabilitas 
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buih dan selektivitas, sehingga menghasilkan recovery yang lebih tinggi [34]. 

Dengan dosis frother 50 ppm, recovery yang dihasilkan menurun karena dosis yang 

terlalu tinggi, sehingga dapat mengganggu pembentukan kontak efektif antara 

gelembung dan partikel mineral. Terlalu banyak frother dapat menghambat 

perlekatan gelembung pada partikel hydrophobic dan mengurangi kecepatan flotasi, 

karena mengganggu pembentukan kontak antara gas-liquid-solid serta 

memperlambat reaksi kinetika dalam proses flotasi [25]. 

Pada variasi dosis frother, dosis 20 ppm merupakan dosis terkecil sementara 

50 ppm merupakan dosis terbesar. Terlihat pada Gambar 4.6, tren kapasitansi dari 

kedua dosis tersebut memiliki kemiripan, di mana pada rentang waktu 0-200 detik, 

tren kapasitansi yang dimiliki kedua variasi terlihat sangat rapat atau berdempetan. 

Namun, nilai kapasitansi dari 50 ppm sedikit lebih tinggi dibanding dengan variasi 

20 ppm. Selain itu, pada retang waktu tersebut tren kumulatif recovery 20 ppm dan 

50 ppm mengalami kenaikan yang hampir sama, namun untuk dosis 20 ppm 

cenderung lebih lambat kenaikannya dibandingkan dengan dosis 50 ppm. Pada 

rentang waktu 200-1000 detik, tren recovery dari 20 ppm masih mangalami 

kenaikan hingga pada waktu 360 detik dan bergerak datar hingga akhir. Sementara 

tren kumulatif recovery dosis 50 ppm telah berhenti naik ketika berada di 240 detik 

karena setelah itu tren bergerak mendatar.  
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Gambar 4.7 Kurva Hubungan Kapasitansi Terhadap Recovery pada Dosis 

Frother 50 ppm. 

 

Gambar 4.7 merupakan kurva yang menunjukkan hubungan kapsitansi 

terhadap recovery dari variasi dosis frother  50 ppm Karena dosis frother 

merupakan variabel bebas, nilainya dapat diatur secara fleksibel. Nilai recovery 

yang dihasilkan merupakan variabel terikat yang akan berubah sesuai dengan 

perubahan dosis frother. Dari kurva tersebut dilakukan pendekatan polinomial orde 

4 untuk memprediksi nilai recovery berdasarkan kapasitansi nya. Persamaan 4.2 

memiliki R² = 0,9981, di mana hal ini menunjukkan kecocokan antara model dan 

data aktual.  

y = 0,0001x4 − 0,0017x3 − 0,1754x2 + 5,5913x− 13,317 ……………………(4.2) 

 

Keterangan: 

y = Nilai recovery flotasi (%) 

x = Nilai kapasitansi (pF) 
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BAB V 

KESIMPULAN DAN SARAN 

 

 

5.1 Kesimpulan 

Kesimpulan yang bisa didapat dari penelitian monitoring flotasi kolom 

dengan variasi ukuran parikel dan dosis frother yaitu: 

1. Ukuran partikel dan dosis frother memiliki pengaruh signifikan 

terhadap recovery. Partikel halus menghasilkan recovery yang lebih 

tinggi (31,28%) dibandingkan partikel kasar (2,17%), dengan kondisi 

optimum tercapai pada 210 detik. Dosis frother meningkatkan recovery 

hingga batas maksimum, di mana kondisi optimum tercapai pada 480 

detik sebelum tren recovery mulai mendatar. Dosis frother yang terlalu 

tinggi menyebabkan stabilitas buih berlebih, sehingga menurunkan 

recovery. Kurva monitoring menunjukkan adanya hubungan linear 

antara recovery dan kapasitansi. 

2. Kapasitansi menurun seiring peningkatan ukuran partikel, dari 26,8 pF 

pada partikel halus menjadi 24,63 pF pada partikel kasar. Selain itu, 

kapasitansi juga menurun dengan peningkatan dosis frother, dari 26,91 

pF menjadi 26,8 pF pada dosis frother tertinggi. 

3. Pendekatan matematis berhasil dirumuskan untuk memprediksi nilai 

recovery berdasarkan perolehan kapasitansi, yang ditunjukkan dengan 
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nilai R2 = 0,9822 untuk ukuran partikel, dan R² = 0,9981 untuk dosis 

frother. 

 

5.2 Saran 

Adapun saran yang didapat setelah melakuan penelitian ini yaitu: 

1. Menggunakan jenis frother berbeda untuk mendapatkan buih yang lebih 

stabil. 

2. Menggunakan jenis partikel lain untuk menguji respons sensor terhadap 

kapasitansi dan recovery.  

3. Menggunakan warna partikel yang lebih kontras untuk memudahkan 

saat analisis grain counting. 
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LAMPIRAN A 

DATA PENELITIAN 

 
 

A.1 Hasil Karakterisasi SiC 

 

Gambar A.1 Pola Grafik XRD SiC 

 

 

Gambar A.2 Hasil Akhir Refinement SiC 
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A.2 Hasil Flotasi Kolom 

 Tabel A.1 Massa konsentrat dan tailing variasi ukuran partikel -100+150# 

Waktu (detik) Massa konsentrat (gram) 

0 0 

150 6,21 

180 0,75 

210 0,61 

240 0,39 

360 1,12 

480 0,49 

600 0,12 

820 0,16 

1000 0,08 

Tailing  85,62 

 

Tabel A.2 Massa konsentrat dan tailing variasi ukuran partikel -150+200# 

Waktu (detik) Massa konsentrat (gram) 

0 0 

150 1,25 

180 1,39 

210 0,49 
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240 0,75 

360 0,88 

480 0,35 

600 0,35 

820 0,43 

1000 0,22 

Tailing 86,22 

 

Tabel A.3 Massa konsentrat dan tailing variasi ukuran partikel -200+230# 

Waktu (detik) Massa konsentrat (gram) 

0 0 

150 0,85 

180 1,11 

210 0,61 

240 1,68 

360 3,98 

480 1,04 

600 1,34 

820 0,26 

1000 0,47 

Tailing 51,22 
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Tabel A.4 Massa konsentrat dan tailing variasi ukuran partikel -230# 

Waktu (detik) Massa konsentrat (gram) 

0 0 

150 15,13 

180 4,77 

210 8,60 

240 5,63 

360 0,65 

480 0,04 

600 0,07 

820 0,59 

1000 0,11 

Tailing 59,1 

 

Tabel A.5 Massa konsentrat dan tailing variasi dosis frother 20 ppm 

Waktu (detik) Massa konsentrat (gram) 

0 0 

150 4,20 

180 0,93 

210 1,64 

240 1,72 
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360 4,69 

480 0,99 

600 0,35 

820 0,41 

1000 0,11 

Tailing 81,94 

 

Tabel A.6 Massa konsentrat dan tailing variasi dosis frother 30 ppm 

Waktu (detik) Massa konsentrat (gram) 

0 0 

150 18,99 

180 4,09 

210 2,27 

240 2,99 

360 11,09 

480 3,67 

600 0,87 

820 0,30 

1000 0,59 

Tailing 44,56 
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Tabel A.7 Massa konsentrat dan tailing variasi dosis frother 40 ppm 

Waktu (detik) Massa konsentrat (gram) 

0 0 

150 36,54 

180 9,33 

210 2,70 

240 3,59 

360 0,98 

480 0,79 

600 0,42 

820 0,12 

1000 0 

Tailing 39,46 

 

Tabel A.8 Massa konsentrat dan tailing variasi dosis frother 50 ppm 

Waktu (detik) Massa konsentrat (gram) 

0 0 

150 15,13 

180 4,77 

210 8,60 

240 5,63 
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360 0,65 

480 0,04 

600 0,07 

820 0,59 

1000 0,11 

Tailing 59,1 

 

Tabel A.9 Grain counting variasi ukuran partikel -100+150# 

Waktu 

(detik) 

Jenis 

Partikel 

(gram) 

Kotak 

1 

Kotak 

3 

Kotak 

5 

Kotak 

7 

Kotak 

9 

Rata-

rata 

0 

SiC 0 0 0 0 0 0 

SiO2 0 0 0 0 0 0 

150 

SiC 27 32 38 16 44 31 

SiO2 840 867 1500 761 1014 996 

180 

SiC 6 65 95 13 130 62 

SiO2 830 2153 843 392 1142 1072 

210 

SiC 47 25 57 82 289 100 

SiO2 1816 2158 2049 1075 2600 1900 

240 

SiC 8 3 13 35 36 19 

SiO2 265 661 327 549 118 384 
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360 

SiC 37 42 47 39 50 43 

SiO2 639 390 977 317 2357 936 

480 

SiC 41 4 4 60 57 33 

SiO2 988 443 1100 1590 1580 1140 

600 

SiC 17 12 14 44 21 22 

SiO2 938 420 652 609 1097 743 

820 

SiC 6 20 52 33 42 31 

SiO2 353 61 789 667 578 490 

1000 

SiC 23 50 3 9 57 28 

SiO2 645 186 482 274 219 361 

 

Tabel A.10 Grain counting variasi ukuran parikel -150+200# 

Waktu 

(detik) 

Jenis 

Partikel 

(gram) 

Kotak 

1 

Kotak 

3 

Kotak 

5 

Kotak 

7 

Kotak 

9 

Rata-

rata 

0 

SiC 0 0 0 0 0 0 

SiO2 0 0 0 0 0 0 

150 

SiC 27 32 38 16 44 31 

SiO2 840 867 1500 761 1014 996 

180 

SiC 6 65 95 13 130 62 

SiO2 830 2153 843 392 1142 1072 
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210 

SiC 47 25 57 82 289 100 

SiO2 1816 2158 2049 1075 2600 1900 

240 

SiC 8 3 13 35 36 19 

SiO2 265 661 327 549 118 384 

360 

SiC 37 42 47 39 50 43 

SiO2 639 390 977 317 2357 936 

480 

SiC 41 4 4 60 57 33 

SiO2 988 443 1100 1590 1580 1140 

600 

SiC 17 12 14 44 21 22 

SiO2 938 420 652 609 1097 743 

820 

SiC 6 20 52 33 42 31 

SiO2 353 61 789 667 578 490 

1000 

SiC 23 50 3 9 57 28 

SiO2 645 186 482 274 219 361 

 

Tabel A.11 Grain counting variasi ukuran partikel -200+230# 

Waktu 

(detik) 

Jenis 

Partikel 

(gram) 

Kotak 

1 

Kotak 

3 

Kotak 

5 

Kotak 

7 

Kotak 

9 

Rata-

rata 

0 SiC 0 0 0 0 0 0 
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SiO2 0 0 0 0 0 0 

150 

SiC 488 295 250 247 222 300 

SiO2 1310 893 1286 1208 2015 1343 

180 

SiC 25 64 129 120 74 82,4 

SiO2 472 303 955 445 496 534 

210 

SiC 38 55 16 53 84 49,2 

SiO2 523 583 236 243 249 367 

240 

SiC 165 45 189 172 288 172 

SiO2 997 874 986 1003 481 868 

360 

SiC 461 184 87 57 116 181 

SiO2 1819 900 1360 821 1001 1180 

480 

SiC 103 55 72 111 128 93,8 

SiO2 1157 789 1322 1493 662 1085 

600 

SiC 139 40 340 250 89 172 

SiO2 1100 1188 1272 1306 689 1111 

820 

SiC 11 21 7 169 29 47,4 

SiO2 607 119 920 465 345 491,2 

1000 

SiC 33 65 6 189 6 60 

SiO2 1084 260 405 653 121 504,6 
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Tabel A.12 Grain counting variasi ukuran partikel -230# 

Waktu 

(detik) 

Jenis 

Partikel 

(gram) 

Kotak 

1 

Kotak 

3 

Kotak 

5 

Kotak 

7 

Kotak 

9 

Rata-

rata 

0 

SiC 0 0 0 0 0 0 

SiO2 0 0 0 0 0 0 

150 

SiC 138 73 212 106 62 118 

SiO2 720 734 1191 813 561 804 

180 

SiC 262 124 209 270 215 216 

SiO2 597 690 361 604 652 581 

210 

SiC 197 121 19 174 51 112 

SiO2 1370 729 842 752 260 791 

240 

SiC 161 180 631 43 200 243 

SiO2 947 788 2740 695 1213 1277 

360 

SiC 139 102 44 60 193 108 

SiO2 575 800 774 513 552 643 

480 

SiC 96 244 118 47 156 132 

SiO2 367 114 329 260 820 378 

600 

SiC 6 47 41 12 3 22 

SiO2 509 770 473 1469 959 836 

820 SiC 35 13 26 43 40 31 
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SiO2 579 759 562 603 652 631 

1000 

SiC 52 140 22 3 4 42 

SiO2 305 498 410 404 739 471 

 

Tabel A.13 Grain counting variasi dosis frother 20 ppm 

Waktu 

(detik) 

Jenis 

Partikel 

(gram) 

Kotak 

1 

Kotak 

3 

Kotak 

5 

Kotak 

7 

Kotak 

9 

Rata-

rata 

0 

SiC 0 0 0 0 0 0 

SiO2 0 0 0 0 0 0 

150 

SiC 136 129 126 191 227 162 

SiO2 390 418 1339 911 655 743 

180 

SiC 207 214 169 195 197 196,4 

SiO2 464 417 485 414 321 420 

210 

SiC 314 255 220 231 375 279 

SiO2 1437 1186 894 1313 1283 1223 

240 

SiC 206 194 177 201 311 218 

SiO2 387 313 1365 720 1437 844 

360 

SiC 148 121 130 38 88 105 

SiO2 205 80 220 49 175 146 

480 SiC 53 59 149 78 120 92 
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SiO2 108 280 720 648 285 408 

600 

SiC 59 62 43 56 98 63,6 

SiO2 285 156 507 410 354 342 

820 

SiC 48 90 143 125 168 115 

SiO2 267 303 745 835 657 561,4 

1000 

SiC 267 171 501 506 108 311 

SiO2 2450 734 3461 935 207 1557 

 

Tabel A.14 Grain counting variasi dosis frother 30 ppm 

Waktu 

(detik) 

Jenis 

Partikel 

(gram) 

Kotak 

1 

Kotak 

3 

Kotak 

5 

Kotak 

7 

Kotak 

9 

Rata-

rata 

0 

SiC 0 0 0 0 0 0 

SiO2 0 0 0 0 0 0 

150 

SiC 1198 415 665 474 692 689 

SiO2 3075 2064 2223 1246 944 1910 

180 

SiC 205 258 27 107 135 146,4 

SiO2 646 450 133 361 504 419 

210 

SiC 173 1146 1049 1521 1095 418,8 

SiO2 535 3906 3135 1989 4058 997 

240 SiC 351 490 1333 272 154 520 
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SiO2 1564 746 2542 478 1461 1358 

360 

SiC 79 77 213 65 320 150,8 

SiO2 1205 245 678 608 294 606 

480 

SiC 63 78 182 392 530 249 

SiO2 577 307 223 425 686 443,6 

600 

SiC 178 197 150 1836 235 519,2 

SiO2 128 227 743 1798 1015 782,2 

820 

SiC 86 70 35 164 17 74,4 

SiO2 238 249 246 471 79 256,6 

1000 

SiC 4 77 18 9 142 50 

SiO2 260 120 351 249 529 302 

 

Tabel A.15 Grain counting variasi dosis frother 40 ppm 

Waktu 

(detik) 

Jenis 

Partikel 

(gram) 

Kotak 

1 

Kotak 

3 

Kotak 

5 

Kotak 

7 

Kotak 

9 

Rata-

rata 

0 

SiC 0 0 0 0 0 0 

SiO2 0 0 0 0 0 0 

150 

SiC 107 82 99 116 453 171,6 

SiO2 638 268 361 324 861 490,4 

180 SiC 195 110 147 53 204 141,8 
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SiO2 493 522 929 479 446 573,8 

210 

SiC 307 32 394 538 30 260,2 

SiO2 171 355 646 726 80 395,6 

240 

SiC 297 42 64 71 69 108,6 

SiO2 633 146 206 166 475 325,2 

360 

SiC 389 49 70 93 130 146,2 

SiO2 574 149 308 335 144 302 

480 

SiC 135 59 180 164 74 122,4 

SiO2 260 390 365 175 197 277,4 

600 

SiC 117 100 243 69 51 116 

SiO2 684 231 636 223 267 408,2 

820 

SiC 117 599 238 114 263 266,2 

SiO2 425 717 635 168 501 489,2 

1000 

SiC 0 0 0 0 0 0 

SiO2 0 0 0 0 0 0 

 

Tabel A.16 Grain counting variasi dosis frother 50 ppm 

Waktu 

(detik) 

Jenis 

Partikel 

(gram) 

Kotak 

1 

Kotak 

3 

Kotak 

5 

Kotak 

7 

Kotak 

9 

Rata-

rata 

0 SiC 0 0 0 0 0 0 
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SiO2 0 0 0 0 0 0 

150 

SiC 138 73 212 106 62 118 

SiO2 720 734 1191 813 561 804 

180 

SiC 262 124 209 270 215 216 

SiO2 597 690 361 604 652 581 

210 

SiC 197 121 19 174 51 112 

SiO2 1370 729 842 752 260 791 

240 

SiC 161 180 631 43 200 243 

SiO2 947 788 2740 695 1213 1277 

360 

SiC 139 102 44 60 193 108 

SiO2 575 800 774 513 552 643 

480 

SiC 96 244 118 47 156 132 

SiO2 367 114 329 260 820 378 

600 

SiC 6 47 41 12 3 22 

SiO2 509 770 473 1469 959 836 

820 

SiC 35 13 26 43 40 31 

SiO2 579 759 562 603 652 631 

1000 

SiC 52 140 22 3 4 42 

SiO2 305 498 410 404 739 471 
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A.3 Hasil Monitoring Kapasitansi dari Kapasitometer CAP 3201 2CH C-

Tech Edwar Labs Technology 

Tabel A.17 Data kapasitometer variasi ukuran partikel -100+150# 

Waktu 

(detik) 

Kapasitansi 

terukur CX 

(pF) 

Kapasitansi 

referensi CR 

(pF) 

Tegangan 

terukur 

VX (mV) 

Tegangan 

referensi 

XR (mV) 

0 2,515 2,867 945 3914 

150 2,515 2,871 945 3918 

180 2,515 2,894 945 3951 

210 2,411 2,909 906 3971 

240 2,411 2,918 906 3983 

360 2,411 2,915 906 3979 

480 2,515 2,891 945 3947 

600 2,515 2,901 945 3960 

820 2,411 2,915 906 3979 

1000 2,411 2,902 906 3961 
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Tabel A.18 Data kapasitometer variasi ukuran partikel -150+200# 

Waktu 

(detik) 

Kapasitansi 

terukur CX 

(pF) 

Kapasitansi 

referensi CR 

(pF) 

Tegangan 

terukur 

VX (mV) 

Tegangan 

referensi 

XR (mV) 

0 2,411 2,911 906 3973 

150 2,411 2,902 906 3961 

180 2,411 2,907 906 3969 

210 2,411 2,902 906 3961 

240 2,411 2,912 906 3975 

360 2,411 2,898 906 3956 

480 2,411 2,906 906 3966 

600 2,411 2,907 906 3968 

820 2,411 2,902 906 3961 

1000 2,411 2,909 906 3871 

 

Tabel A.19 Data kapasitometer variasi ukuran partikel -200+230# 

Waktu 

(detik) 

Kapasitansi 

terukur CX 

(pF) 

Kapasitansi 

referensi CR 

(pF) 

Tegangan 

terukur 

VX (mV) 

Tegangan 

referensi 

XR (mV) 

0 2,411 2,893 906 3949 

150 2,307 2,917 867 3981 

180 2,307 2,916 867 3980 

210 2,411 2,894 906 3950 
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240 2,411 2,900 906 3959 

360 2,411 2,893 906 3949 

480 2,307 2,946 867 4021 

600 2,307 2,943 867 4017 

820 2,411 2,924 906 3991 

1000 2,411 2,923 906 3990 

  

Tabel A.20 Data kapasitometer variasi ukuran partikel -230# 

Waktu 

(detik) 

Kapasitansi 

terukur CX 

(pF) 

Kapasitansi 

referensi CR 

(pF) 

Tegangan 

terukur 

VX (mV) 

Tegangan 

referensi 

XR (mV) 

0 2,619 2,907 984 3968 

150 2,619 2,917 984 3982 

180 2,619 2,918 984 384 

210 2,723 2,890 1023 3945 

240 2,917 2,917 984 3981 

360 2,827 2,934 1063 4005 

480 2,619 2,940 984 4013 

600 2,619 2,938 984 4010 

820 2,619 2,930 984 3999 

1000 2,619 2,945 984 4020 
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Tabel A.21 Data kapasitometer variasi dosis frother 20 ppm 

Waktu 

(detik) 

Kapasitansi 

terukur CX 

(pF) 

Kapasitansi 

referensi CR 

(pF) 

Tegangan 

terukur 

VX (mV) 

Tegangan 

referensi 

XR (mV) 

0 2,619 2,908 984 3969 

150 2,619 2,934 984 4005 

180 2,619 2,939 984 4012 

210 2,619 2,930 984 4000 

240 2,619 2,944 984 4018 

360 2,619 2,938 984 4011 

480 2,723 2,920 1023 3985 

600 2,723 2,924 1023 3991 

820 2,723 2,923 1023 3990 

1000 2,723 2,924 1023 3991 

 

Tabel A.22 Data kapasitometer variasi dosis frother 30 ppm 

Waktu 

(detik) 

Kapasitansi 

terukur CX 

(pF) 

Kapasitansi 

referensi 

CR (pF) 

Tegangan 

terukur 

VX (mV) 

Tegangan 

referensi 

XR (mV) 

0 2,656 2,897 1453 3995 

150 2,727 2,924 1492 3991 
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180 2,727 2,924 1492 3991 

210 2,727 2,922 1492 3988 

240 2,656 2,942 1453 4016 

360 2,870 2,939 1570 4012 

480 2,941 2,940 1609 4013 

600 2,656 2,941 1453 4014 

820 2,656 2,941 1453 4014 

1000 2,656 2,939 1453 4012 

 

Tabel A.23 Data kapasitometer variasi dosis frother 40 ppm 

Waktu 

(detik) 

Kapasitansi 

terukur CX 

(pF) 

Kapasitansi 

referensi 

CR (pF) 

Tegangan 

terukur 

VX (mV) 

Tegangan 

referensi 

XR (mV) 

0 2,619 2,910 984 3973 

150 2,723 2,928 1023 3997 

180 2,723 2,925 1023 3991 

210 2,723 2,919 1023 3985 

240 2,619 2,947 984 4023 

360 2,723 2,920 1023 3986 

480 2,723 2,924 1023 3991 

600 2,619 2,945 984 4021 

820 2,723 2,924 1023 3991 

1000 2,723 2,929 1023 3998 
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Tabel A.24 Data kapasitometer variasi dosis frother 50 ppm 

Waktu 

(detik) 

Kapasitansi 

terukur CX 

(pF) 

Kapasitansi 

referensi CR 

(pF) 

Tegangan 

terukur 

VX (mV) 

Tegangan 

referensi 

XR (mV) 

0 2,619 2,907 984 3968 

150 2,619 2,917 984 3982 

180 2,619 2,918 984 3984 

210 2,723 2,890 1023 3945 

240 2,917 2,917 984 3981 

360 2,827 2,934 1063 4005 

480 2,619 2,940 984 4013 

600 2,619 2,938 984 4010 

820 2,619 2,930 984 3999 

1000 2,619 2,945 984 4020 

 

A.4 Grain counting  
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Gambar A.3 Citra grain counting variasi ukuran partikel -100+150# di 150 detik: 

a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.4 Citra grain counting variasi ukuran partikel -100+150# di 180 detik: 

a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.5 Citra grain counting variasi ukuran partikel -100+150# di 210 detik: 

a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.6 Citra grain counting variasi ukuran partikel -100+150# di 240 detik: 

a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.7 Citra grain counting variasi ukuran partikel -100+150# di 360 detik: 

a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.8 Citra grain counting variasi ukuran partikel -100+150# di 480 detik: 

a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.9 Citra grain counting variasi ukuran partikel -100+150# di 600 detik: 

a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.10 Citra grain counting variasi ukuran partikel -100+150# di 820 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.11 Citra grain counting variasi ukuran partikel -100+150# di 1000 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.12 Citra grain counting variasi ukuran partikel -150+200# di 150 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.13 Citra grain counting variasi ukuran partikel -150+200# di 180 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.14 Citra grain counting variasi ukuran partikel -150+200# di 210 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.15 Citra grain counting variasi ukuran partikel -150+200# di 240 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.16 Citra grain counting variasi ukuran partikel -150+200# di 360 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.17 Citra grain counting variasi ukuran partikel -150+200# di 480 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.18 Citra grain counting variasi ukuran partikel -150+200# di 600 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.19 Citra grain counting variasi ukuran partikel -150+200# di 820 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.20 Citra grain counting variasi ukuran partikel -150+200# di 1000 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.21 Citra grain counting variasi ukuran partikel -200+230# di 150 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.22 Citra grain counting variasi ukuran partikel -200+230# di 180 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.23 Citra grain counting variasi ukuran partikel -200+230# di 210 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.24 Citra grain counting variasi ukuran partikel -200+230# di 240 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.25 Citra grain counting variasi ukuran partikel -200+230# di 360 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.26 Citra grain counting variasi ukuran partikel -200+230# di 480 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.27 Citra grain counting variasi ukuran partikel -200+230# di 600 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.28 Citra grain counting variasi ukuran partikel -200+230# di 820 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.29 Citra grain counting variasi ukuran partikel -200+230# di 1000 

detik: a) kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.30 Citra grain counting variasi ukuran partikel -230# di 150 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.31 Citra grain counting variasi ukuran partikel -230# di 180 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.32 Citra grain counting variasi ukuran partikel -230# di 210 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.33 Citra grain counting variasi ukuran partikel -230# di 240 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.34 Citra grain counting variasi ukuran partikel -230# di 360 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.35 Citra grain counting variasi ukuran partikel -230# di 480 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.36 Citra grain counting variasi ukuran partikel -230# di 600 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.37 Citra grain counting variasi ukuran partikel -230# di 820 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.38 Citra grain counting variasi ukuran partikel -230# di 1000 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.39 Citra grain counting variasi dosis frother 20 ppm di 150 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.40 Citra grain counting variasi dosis frother 20 ppm di 180 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.41 Citra grain counting variasi dosis frother 20 ppm di 210 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.42 Citra grain counting variasi dosis frother 20 ppm di 240 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.43 Citra grain counting variasi dosis frother 20 ppm di 360 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.44 Citra grain counting variasi dosis frother 20 ppm di 480 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.45 Citra grain counting variasi dosis frother 20 ppm di 600 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.46 Citra grain counting variasi dosis frother 20 ppm di 820 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.47 Citra grain counting variasi dosis frother 20 ppm di 1000 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.48 Citra grain counting variasi dosis frother 30 ppm di 150 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.49 Citra grain counting variasi dosis frother 30 ppm di 180 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.50 Citra grain counting variasi dosis frother 30 ppm di 210 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.51 Citra grain counting variasi dosis frother 30 ppm di 240 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.52 Citra grain counting variasi dosis frother 30 ppm di 360 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.53 Citra grain counting variasi dosis frother 30 ppm di 480 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.54 Citra grain counting variasi dosis frother 30 ppm di 600 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.55 Citra grain counting variasi dosis frother 30 ppm di 820 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.56 Citra grain counting variasi dosis frother 30 ppm di 1000 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.57 Citra grain counting variasi dosis frother 40 ppm di 150 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.58 Citra grain counting variasi dosis frother 40 ppm di 180 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.59 Citra grain counting variasi dosis frother 40 ppm di 210 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.60 Citra grain counting variasi dosis frother 40 ppm di 240 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.61 Citra grain counting variasi dosis frother 40 ppm di 360 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.62 Citra grain counting variasi dosis frother 40 ppm di 480 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.63 Citra grain counting variasi dosis frother 40 ppm di 600 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.64 Citra grain counting variasi dosis frother 40 ppm di 820 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.65 Citra grain  counting variasi dosis frother 50 ppm di 150 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.66 Citra grain counting variasi dosis frother 50 ppm di 180 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.67 Citra grain counting variasi dosis frother 50 ppm di 210 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.68 Citra grain counting variasi dosis frother 50 ppm di 240 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.69 Citra grain counting variasi dosis frother 50 ppm di 360 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.70 Citra grain counting variasi dosis frother 50 ppm di 480 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.71 Citra grain counting variasi dosis frother 50 ppm di 600 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 

 

 

Gambar A.72 Citra grain counting variasi dosis frother 50 ppm di 840 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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Gambar A.73 Citra grain counting variasi dosis frother 50 ppm di 1000 detik: a) 

kotak 1, b) kotak 3, c) kotak 5, d) kotak 7, dan e) kotak 9 
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LAMPIRAN B 

CONTOH PERHITUNGAN 

 

 

B.1 Perhitungan Kadar Feed 

Dalam penelitian ini, silikon karbida yang digunakan adalah 20% dari total 

umpan yang berjumlah 100 g. Perhitungan massa silikon karbida dan kuarsa yaitu: 

Kadar SiC= 
Massa SiC
Massa Feed

×100% ………………. (B.1) 

20% =
Massa SiC
100 gram

×100%  

Massa SiC = 
20% × 100 gram

100%
=20	gram  

Massa kuarsa = Massa feed  - massa SiC……….(B.2) 

Massa kuarsa = 100 gram – 20 gram = 80 gram 

 

B.2 Perhitungan Persen Solid 

 Persentase solid yang digunakan pada penelitian ini adalah 20 %. Jumlah 

massa feed yang digunakan 100 gram, maka air yang dibutuhkan yaitu: 

% solid = 
Massa padatan

Massa padatan + massa air
×100% …… (B.3) 

20% = 
100 gram

100 gram + massa air
×100%  

100 gram + massa air = 
100 gram

20%
×100%   

100 gram + massa air = 500 gram 

Massa air = 500 – 100 gram = 400 gram 

Massa air = 400 gram = 400 mL 
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 B.3 Perhitungan Dosis Frother 

 Massa campuran antara feed dan air yang digunakan pada penelitian ini 

adalah 500 gram. Variasi dosis frother yang digunakan adalah 20 ppm, 30 ppm, 40 

ppm, dan 50 ppm, sehingga massa frother yang digunakan dapat dihitung dengan 

persamaan: 

 Dosis ppm = 
Massa frother

Massa padatan campuran
×10

6
 .…….…(B.4) 

20 ppm = 
Massa kolektor

500 gram
×10

6
  

Massa frother = 
10 × 500 gram

106
= 0,01 gram  

 

Tabel B.1 Penentuan dosis frother  

Massa Campuran (gram) Dosis Frother (ppm) Massa Frother (gram) 

500 

20 0,01 

30 0,015 

40 0,02 

50 0,025 

 

B.4 Perhitungan Dosis Kolektor 

 Dosis kolektor yang digunakan pada penelitian ini adalah 40 ppm, sehingga 

massa kolektor yang digunakan dapat dihitung dengan persamaan: 

 Dosis ppm = 
Massa kolektor

Massa padatan campuran
×10

6
 .…… (B.5) 

40 ppm = 
Massa kolektor

500 gram
×10

6
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Massa kolektor = 
40 × 500 gram

106
= 0,02 gram  

 

 B.5  Perhitungan Kadar Konsentrat 

 Perhitungan kadar konsentrat dilakukan dengan mengganti massa partikel 

SiC dan SiO2 menjadi massa jenis dalam rumus konsentrat. Volume keduanya 

dianggap sama karena berada pada fraksi ukuran yang sama. Perhitungan ini 

dilakukan untuk setiap waktu interval dengan persamaan: 

Kadar SiC pada konsentrat = 

Jumlah partikel SiC×ρ SiC
(Jumlah partikel SiC×ρ SiC)+(Jumlah partikel SiO2×ρSiO2)

×100% …………………………(B.6) 

Kadar SiO2 pada konsentrat = 

Jumlah partikel SiC×ρ SiC
(Jumlah partikel SiC×ρ SiC)+(Jumlah partikel SiO2×ρSiO2)

×100% …………………………(B.7) 

 

Berikut merupakan contoh hasil dari perhitungan untuk kadar partikel 

variasi dosis frother 40 ppm di waktu 150 detik. 

Kadar SiC pada konsentrat = 
171,60 × 3,21 g/mL

(171,60 × 3,21 g/mL)+(490,40 × 2,65 g/mL)
×100%   

Kadar SiC pada konsentrat = 29,77% 

 

Kadar SiO2 pada konsentrat = 
490,40 × 2,65

(171,60 × 3,21 g/mL)+(490,40 × 2,65 g/mL)
×100%  

Kadar SiO2 pada konsentrat = 70,23% 

Tabel B.2 Kadar SiC dan SiO2 pada variasi ukuran partikel -100+150# 

Waktu (detik) Kadar SiC (%) Kadar SiO2 (%) 



 

109 

 

0 0 0 

150 3,68 96,32 

180 6,53 93,47 

210 5,99 94,01 

240 5,65 94,35 

360 5,27 94,73 

480 3,41 96,59 

600 3,40 96,60 

820 7,04 92,96 

1000 8,70 91,30 

 

Tabel B.3 Kadar SiC dan SiO2 pada variasi ukuran partikel -150+200# 

Waktu (detik) Kadar SiC (%) Kadar SiO2 (%) 

0 0 0 

150 4,67 95,33 

180 7,11 92,89 

210 3,34 96,66 

240 8,07 91,93 

360 10,21 89,79 

480 11,41 88,59 

600 15,31 84,69 

820 7,00 93,00 

1000 10,34 89,66 
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Tabel B.4 Kadar SiC dan SiO2 pada variasi ukuran partikel -200+230# 

Waktu (detik) Kadar SiC (%) Kadar SiO2 (%) 

0 0 0 

150 21,33 78,67 

180 15,74 84,26 

210 13,98 86,02 

240 19,34 80,66 

360 15,67 84,33 

480 9,48 90,52 

600 15,76 84,24 

820 10,47 89,53 

1000 12,55 87,45 

 

Tabel B.5 Kadar SiC dan SiO2 pada variasi ukuran partikel -230# 

Waktu (detik) Kadar SiC (%) Kadar SiO2 (%) 

0 0 0 

150 15,12 84,88 

180 31,06 68,94 

210 14,69 85,31 

240 18,74 81,26 

360 16,86 83,14 

480 29,76 70,24 

600 3,06 96,94 
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820 5,69 94,31 

1000 9,79 90,21 

 

Tabel B.6 Kadar SiC dan SiO2 pada variasi dosis frother 20 ppm 

Waktu (detik) Kadar SiC (%) Kadar SiO2 (%) 

0 0 0 

150 20,88 79,12 

180 36,15 63,85 

210 21,66 78,34 

240 23,81 76,19 

360 46,59 53,41 

480 21,41 78,59 

600 18,37 81,63 

820 19,85 80,15 

1000 19,46 80,54 

 

Tabel B.7 Kadar SiC dan SiO2 pada variasi dosis frother 30 ppm 

Waktu (detik) Kadar SiC (%) Kadar SiO2 (%) 

0 0 0 

150 30,40 69,60 

180 29,75 70,25 

210 30,71 69,29 

240 31,68 68,32 
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360 23,16 76,84 

480 40,47 59,53 

600 44,57 55,43 

820 25,99 74,01 

1000 16,71 83,29 

 

Tabel B.8 Kadar SiC dan SiO2 pada variasi dosis frother 40 ppm 

Waktu (detik) Kadar SiC (%) Kadar SiO2 (%) 

0 0 0 

150 29,77 70,23 

180 23,04 76,96 

210 44,34 55,66 

240 28,80 71,20 

360 36,96 63,04 

480 34,83 65,17 

600 25,61 74,39 

820 39,73 60,27 

1000 0,00 0,00 

 

Tabel B.9 Kadar SiC dan SiO2 pada variasi dosis frother 50 ppm 

Waktu (detik) Kadar SiC (%) Kadar SiO2 (%) 

0 0 0 

150 15,12 84,88 
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180 31,06 68,94 

210 14,69 85,31 

240 18,74 81,26 

360 16,86 83,14 

480 29,76 70,24 

600 3,06 96,94 

820 5,69 94,31 

1000 9,79 90,21 

 

B.6 Perhitungan Recovery dan Kumulatif Recovery 

 Perhitungan recovery dan kumulatif recovery dilakukan setelah massa dan 

kadar dari silikon karbida pada konsentrat diketahui. Untuk menghitung recovery, 

menggunakan Persamaan B.8, dan untuk menghitung kumulatif recovery 

menggunakan Persamaan B.9 berikut: 

% Recovery  = 
Kadar SiC × Massa konsentrat

Kadar feed × Massa feed
×100% ……………...…………………(B.8)  

% Kumulatif recovery = % recovery + % recovery sebelumnya ……………….(B.9) 

Berikut merupakan contoh hasil dari perhitungan recovery untuk kadar 

partikel variasi dosis frother 40 ppm di waktu 150 detik. 

% Recovery = 
29,77 % × 36,54 gram

20 % × 100 gram
×100%  

% Recovery = 54,39% 
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Tabel B.10 Recovery dan Kumulatif Recovery Variasi Ukuran Partikel -100+150# 

Waktu (detik) Recovery (%) Kumulatif Recovery (%) 

0 0 0 

150 1,142 1 

180 0,245 1 

210 0,183 2 

240 0,110 2 

360 0,295 2 

480 0,083 2 

600 0,020 2 

820 0,056 2 

1000 0,035 2,17 

 

Tabel B.11 Recovery dan Kumulatif Recovery Variasi Ukuran Partikel -150+200# 

Waktu (detik) Recovery (%) Kumulatif Recovery (%) 

0 0 0 

150 0,292 0,29 

180 0,494 0,79 

210 0,082 0,87 

240 0,303 1,17 

360 0,449 1,62 

480 0,200 1,82 

600 0,268 2,09 
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820 0,151 2,24 

1000 0,114 2,35 

 

Tabel B.12 Recovery dan Kumulatif Recovery Variasi Ukuran Partikel -200+230# 

Waktu (detik) Recovery (%) Kumulatif Recovery (%) 

0 0 0 

150 0,906 0,91 

180 0,874 1,78 

210 0,426 2,21 

240 1,624 3,83 

360 3,118 6,95 

480 0,493 7,44 

600 1,056 8,50 

820 0,136 8,63 

1000 0,295 8,93 

 

Tabel B.13 Recovery dan Kumulatif Recovery Variasi Ukuran Partikel -230# 

Waktu (detik) Recovery (%) Kumulatif Recovery (%) 

0 0 0 

150 11,44 11,44 

180 7,41 18,85 

210 6,32 25,16 

240 5,27 30,44 
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360 0,55 30,98 

480 0,06 31,04 

600 0,01 31,06 

820 0,17 31,22 

1000 0,05 31,28 

 

Tabel B.14 Recovery dan Kumulatif Recovery Variasi Dosis Frother 20 ppm 

Waktu (detik) Recovery (%) Kumulatif Recovery (%) 

0 0 0 

150 4,39 4,39 

180 1,68 6,07 

210 1,78 7,84 

240 2,05 9,89 

360 10,93 20,81 

480 1,06 21,87 

600 0,32 22,20 

820 0,41 22,60 

1000 0,11 22,71 

 

Tabel B.15 Recovery dan Kumulatif Recovery Variasi Dosis Frother 30 ppm 

Waktu (detik) Recovery (%) Kumulatif Recovery (%) 

0 0 0 

150 28,86 28,86 
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180 6,08 34,95 

210 3,49 38,43 

240 4,74 43,17 

360 12,84 56,01 

480 7,43 63,44 

600 1,94 65,38 

820 0,39 65,77 

1000 0,49 66,26 

 

Tabel B.16 Recovery dan Kumulatif Recovery Variasi Dosis Frother 40 ppm 

Waktu (detik) Recovery (%) Kumulatif Recovery (%) 

0 0 0 

150 54,39 54,39 

180 10,75 65,13 

210 5,99 71,12 

240 5,17 76,29 

360 1,81 78,10 

480 1,38 79,48 

600 0,54 80,02 

820 0,24 80,25 

1000 0 22,71 
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Tabel B.17 Recovery dan Kumulatif Recovery Variasi Dosis Frother 50 ppm 

Waktu (detik) Recovery (%) Kumulatif Recovery (%) 

0 0 0 

150 11,44 11,44 

180 7,41 18,85 

210 6,32 25,16 

240 5,27 30,44 

360 0,55 30,98 

480 0,06 31,04 

600 0,01 31,06 

820 0,17 31,22 

1000 0,05 31,28 
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LAMPIRAN C 

GRAIN COUNTING 

 

 

C.1 Analisis Grain Counting Menggunakan ImageJ 1.53t 

 Untuk menghitung jumlah partikel pada sampel konsentrat di setiap kotak 

selama proses grain counting, digunakan software ImageJ 1.53t. Proses ini 

dilakukan melalui beberapa tahap. Tahap pertama adalah membuka ImageJ 1.53t, 

lalu memilih menu “File” > “Open” untuk membuka citra yang akan dianalisis 

(Gambar C.1). Selanjutnya, pilih menu “Image” > “Adjust” > “Color Threshold…” 

untuk mengatur parameter seperti Hue, Saturation, dan Brightness sesuai dengan 

karakteristik warna atau tingkat kecerahan partikel yang akan dihitung (Gambar 

C.2). Setelah itu, pilih menu “Process” > “Binary” > “Make Binary” untuk 

mengubah citra menjadi hitam-putih tanpa warna abu-abu atau warna lainnya 

(Gambar C.3). Hal ini bertujuan agar objek utama (putih) dan latar belakang (hitam) 

terlihat jelas perbedaannya, sebagaimana ditunjukkan pada Gambar C.4. Tahapan 

setelah itu dilakukan pada menu “Binary” dengan opsi yang berbeda. Yang pertama, 

pilih “Convert to Mask” untuk menyorot atau menandai area yang difokuskan 

(Gambar C.5), ke dua pilih “Fill Holes” untuk mengisi area yang kosong atau 

lubang-lubang keci (Gambar C.6), dan yang terakhir adalah menu “Watershed” 

yang berguna untuk memisahkan objek atau partikel yang terdeteksi saling 

menempel (Gambar C.7). Pilih menu “Analyze” > “Analyze Particles…” untuk 

menganalisis jumlah partikel pada citra. Atur opsi “Show” dari “Nothing” ke 
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“Overlay Masks” agar mask hasil analisis biner (pada menu “Binary”) sebelumnya 

dapat ditampilkan. Pengaturan ini membantu memvisualisasikan objek yang telah 

dihitung atau dianalisis oleh ImageJ (Gambar C.8 dan C.9). Hasil analisis (Gambar 

C.10) akan menampilkan jumlah partikel yang dihitung dalam bentuk angka. 

 

Gambar C.1 Menu “Open” pada “File” Untuk Membuka Citra  

 

 

Gambar C.2 Menu “Color Threshold…” pada “Adjust” 
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Gambar C.3 Pengaruran “Threshold Color” 

 

 

Gambar C.4 a) Menu “Make Binary” pada “Binary”, b) Hasil dari “Make 

Binary” 
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Gambar C.5 Menu “Convert to Mask” pada “Binary” 

 

 

Gambar C.6 Menu “Fill Holes” pada “Binary” 
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Gambar C.7 Menu “Watershed” pada “Binary” 

 

 

Gambar C.8 Menu “Analyze Particles…” pada “Analyze” 
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Gambar C.9 Pengaturan pada “Analyze Particles” 

 

 

Gambar C.10 Hasil Akhir Analisis Grain Counting dengan ImageJ 
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LAMPIRAN D 

ANALISIS POLA XRD 

 

 

D.1 Analisis Pola XRD Menggunakan Profex 5.2.5 

Setelah mendapat pola difraksi XRD sampel SiC, analilisis dilakukan 

menggunakan software Profex 5.2.5. Pertama, buka raw file pola XRD di Profex 

dengan memilih menu “File” > “Open Raw Scan File …” dan pilih file pola XRD 

yang akan dianalisis (Gambar D.1). Pada kolom “Search/Match Phases”, terdapat 

menu “Phases”, lalu pilih SiC dan BGM untuk mengklasifikasikan puncak-puncak 

dengan data base nya (Gambar D.2). Selanjutnya pada menu “Restrictions”, pilih 

Si dan C sebagai pembatas jenis unsur yang akan dianalisis (Gambar D.3). Lalu 

pada “Controls” instrument yang dipilih disesuaikan dengan konfigurasi pengujian 

XRD (Gambar D.4). Setelah itu, pilh menu “Run” > “Run Search-Match” untuk 

mulai menganalisis. Setelah proses selesai, tampilan Profex akan seperti pada 

Gambar D.5. Proses Search-Match diulang dengan menandai fasa yang memiliki 

nilai FoM tertinggi menggunakan tanda panah ke bawah pada kolom “Result”. 

Proses ini berlanjut hingga fasa yang ditampilkan menunjukkan kecocokan yang 

rendah dengan database, ditandai dengan nilai FoM yang tidak lagi berwarna hijau 

(Gambar D.6). Terakhir merupakan “Refinement” dengan memilih menu 

“Add/remove phase” untuk mendapat hasil seperti Gambar D.7 dan tabel dari 

chemical compositions nya. 
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Gambar D.1 Menu “Open Raw Scan File…” pada “File” 

 

 

Gambar D.2 “Phases” pada Kolom “Search/Match Phases” 

 

 

Gambar D.3 “Restrictions” pada Kolom “Search/Match Phases” 
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Gambar D.4 “Controls” pada Kolom “Search/Match Phases” 

 

 

Gambar D.5 Menu “Run Search-Match” pada “Run” 
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Gambar D.6 “Results” pada kolom “Search/Match Phases” 

 

 

Gambar D.7 Hasil Akhir dari Analisis Pola XRD 
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LAMPIRAN E 
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LAMPIRAN E 

GAMBAR ALAT DAN BAHAN 

 

 

E.1 Gambar Alat 

 

Gambar E.1 Chopper 

 

Gambar E.2 Ember 

 

Gambar E.3 Flowmeter 

 

Gambar E.4 Gelas kimia 500 mL 

 

Gambar E.5 Kapasitometer 

 

Gambar E.6 Kolom flotasi 
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Gambar E.7 Kompresor udara 

 

Gambar E.8 Kabel konektor 

 

Gambar E.9 Kaca arloji 

 

Gambar E.10 Kaca pembesar 

 

Gambar E.11 Hand mixer  

 

Gambar E.12 Nampan Logam  

 

Gambar E.13 Neraca digital 

 

Gambar E.14 Oven 
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Gambar E.15 Screen 100#, 150#, 

200#, dan 2230# 

 

Gambar E.16 Stabilizer 

 

Gambar E.17 Termometer digital 

 

Gambar E.18 Water sprayer 

 

 

E.2 Gambar Bahan 

 

Gambar E.19 Frother pine oil 

 

Gambar E.20 Kolektor Methyl ester 

sulfonate 
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Gambar E.21 Kuarsa (SiO2) 

 

Gambar E.22 SiC 

 


